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• For safety and warning information, please read this 
manual before attempting to use the equipment. 

• Additional safety and warning information is provided 
within the MG3700A Vector Signal Generator 
Operation Manual (Mainframe), MG3710A Vector 
Signal Generator MG3740A Analog Signal Generator 
Operation Manual (Mainframe), 
MS2690A/MS2691A/MS2692A Signal Analyzer 
Operation Manual (Mainframe Operation), or 
MS2830A Signal Analyzer Operation Manual 
(Mainframe Operation). Please also refer to either of 
these documents before using the equipment. 

• Keep this manual with the equipment. 
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Safety Symbols 
To prevent the risk of personal injury or loss related to equipment malfunction, Anritsu Corporation uses the 
following safety symbols to indicate safety-related information. Ensure that you clearly understand the meanings of 
the symbols BEFORE using the equipment. Some or all of the following symbols may be used on all Anritsu 
equipment. In addition, there may be other labels attached to products that are not shown in the diagrams in this 
manual. 
 

Symbols used in manual 
This indicates a very dangerous procedure that could result in serious injury or 
death if not performed properly. 
 

This indicates a hazardous procedure that could result in serious injury or death if 
not performed properly. 
 
This indicates a hazardous procedure or danger that could result in light-to-severe 
injury, or loss related to equipment malfunction, if proper precautions are not taken. 

 

Safety Symbols Used on Equipment and in Manual 
The following safety symbols are used inside or on the equipment near operation locations to provide information 
about safety items and operation precautions. Ensure that you clearly understand the meanings of the symbols and 
take the necessary precautions BEFORE using the equipment. 
 
 

 
This indicates a prohibited operation. The prohibited operation is indicated 
symbolically in or near the barred circle. 

 
  This indicates an obligatory safety precaution. The obligatory operation is 

indicated symbolically in or near the circle. 
 
  This indicates a warning or caution. The contents are indicated symbolically in or 

near the triangle. 
 
  This indicates a note. The contents are described in the box. 
 
 
  These indicate that the marked part should be recycled. 

 

MX370112A/MX269912A 
TD-SCDMA IQproducer 
Operation Manual 
 
20 March 2012 (First Edition) 
25 November 2014(Fourth Edition) 
 
Copyright © 2012-2014, ANRITSU CORPORATION. 
All rights reserved. No part of this manual may be reproduced without the prior written permission of the 
publisher. 
The contents of this manual may be changed without prior notice. 
Printed in Japan 
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Equipment Certificate 
Anritsu Corporation guarantees that this equipment was inspected at 
shipment and meets the published specifications. 
 
 

Anritsu Warranty 
• During the warranty period, Anritsu Corporation will repair or exchange this 

software free-of-charge if it proves defective when used as described in the 
operation manual. 

• The warranty period is 6 months from the purchase date. 
• The warranty period after repair or exchange will remain 6 months from 

the original purchase date, or 30 days from the date of repair or 
exchange, depending on whichever is longer. 

• This warranty does not cover damage to this software caused by Acts of 
God, natural disasters, and misuse or mishandling by the customer. 

 
In addition, this warranty is valid only for the original equipment purchaser. It 
is not transferable if the equipment is resold. 
 
Anritsu Corporation shall assume no liability for injury or financial loss of the 
customer due to the use of or a failure to be able to use this equipment. 
 
 

Anritsu Corporation Contact 
In the event that this equipment malfunctions, contact an Anritsu Service and 
Sales office. Contact information can be found on the last page of the printed 
version of this manual, and is available in a separate file on the CD version. 
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Notes On Export Management 
This product and its manuals may require an Export License/Approval by 
the Government of the product's country of origin for re-export from your 
country. 
Before re-exporting the product or manuals, please contact us to confirm 
whether they are export-controlled items or not. 
When you dispose of export-controlled items, the products/manuals need 
to be broken/shredded so as not to be unlawfully used for military purpose. 
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Software End-User License Agreement (EULA) 
Please read this Software End-User License Agreement (hereafter this EULA) carefully before using 
(includes executing, copying, registering, etc.) this software (includes programs, databases, scenarios, 
etc., used to operate, set, etc., Anritsu electronic equipment). By reading this EULA and using this 
software, you are agreeing to be bound by the terms of its contents and Anritsu Corporation (hereafter 
Anritsu) hereby grants you the right to use this Software with the Anritsu-specified equipment 
(hereafter Equipment) for the purposes set out in this EULA. 
 
1. Grant of License and Limitations 

1. Regardless of whether this Software was 
purchased from or provided free-of-charge by 
Anritsu, you agree not to rent, lease, lend, or 
otherwise distribute this Software to third 
parties and further agree not to disassemble, 
recompile, reverse engineer, modify, or create 
derivative works of this Software. 

2. You may make one copy of this Software for 
backup purposes only. 

3. You are not permitted to reverse engineer 
this software. 

4. This EULA allows you to install one copy of 
this Software on one piece of Equipment.  

2. Disclaimers 
 To the extent not prohibited by law, in no 

event shall Anritsu be liable for personal 
injury, or any incidental, special, indirect or 
consequential damages whatsoever, 
including, without limitation, damages for 
loss of profits, loss of data, business 
interruption or any other commercial 
damages or losses, arising out of or related 
to your use or inability to use this Software. 

 
 

3. Limitation of Liability 
a. If a fault (bug) is discovered in this Software, 

preventing operation as described in the 
operation manual or specifications whether 
or not the customer uses this software as 
described in the manual, Anritsu shall at its 
own discretion, fix the bug, or exchange the 
software, or suggest a workaround, 
free-of-charge. However, notwithstanding 
the above, the following items shall be 
excluded from repair and warranty.  

i) If this Software is deemed to be used for 
purposes not described in the operation 
manual or specifications. 

ii) If this Software is used in conjunction with 
other non-Anritsu-approved software. 

iii) Recovery of lost or damaged data. 
iv) If this Software or the Equipment has been 

modified, repaired, or otherwise altered 
without Anritsu's prior approval. 

v) For any other reasons out of Anritsu's direct 
control and responsibility, such as but not 
limited to, natural disasters, software virus 
infections, etc. 

b. Expenses incurred for transport, hotel, daily 
allowance, etc., for on-site repairs by Anritsu 
engineers necessitated by the above faults 
shall be borne by you. 

c. The warranty period for faults listed in 
article 3a above covered by this EULA shall 
be either 6 months from the date of purchase 
of this Software or 30 days after the date of 
repair, whichever is longer. 
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4. Export Restrictions 
 You may not use or otherwise export or 

re-export directly or indirectly this Software 
except as authorized by Japanese and 
United States law. In particular, this 
software may not be exported or re-exported 
(a) into any Japanese or US embargoed 
countries or (b) to anyone on the Japanese or 
US Treasury Department's list of Specially 
Designated Nationals or the US Department 
of Commerce Denied Persons List or Entity 
List. By using this Software, you warrant 
that you are not located in any such country 
or on any such list. You also agree that you 
will not use this Software for any purposes 
prohibited by Japanese and US law, 
including, without limitation, the 
development, design and manufacture or 
production of missiles or nuclear, chemical or 
biological weapons of mass destruction. 

5. Termination 
 Anritsu shall deem this EULA terminated if 

you violate any conditions described herein. 
This EULA shall also be terminated if the 
conditions herein cannot be continued for 
any good reason, such as violation of 
copyrights, patents, or other laws and 
ordinances. 

6. Reparations 
 If Anritsu suffers any loss, financial or 

otherwise, due to your violation of the terms 
of this EULA, Anritsu shall have the right to 
seek proportional damages from you. 

7. Responsibility after Termination 
 Upon termination of this EULA in 

accordance with item 5, you shall cease all 
use of this Software immediately and shall 
as directed by Anritsu either destroy or 
return this Software and any backup copies, 
full or partial, to Anritsu. 

8. Dispute Resolution 
 If matters of dispute or items not covered by 

this EULA arise, they shall be resolved by 
negotiations in good faith between you and 
Anritsu. 

9. Court of Jurisdiction 
 This EULA shall be interpreted in 

accordance with Japanese law and any 
disputes that cannot be resolved by 
negotiation described in Article 8 shall be 
settled by the Japanese courts. 
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Cautions against computer virus infection 
• Copying files and data 
 Only files that have been provided directly from Anritsu or generated 

using Anritsu equipment should be copied to the instrument. 
 All other required files should be transferred by means of USB or 

CompactFlash media after undergoing a thorough virus check. 
• Adding software 
 Do not download or install software that has not been specifically 

recommended or licensed by Anritsu.  
• Network connections 
 Ensure that the network has sufficient anti-virus security protection in 

place. 
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Protection Against Computer Virus Infections 

Prior to the software installation 
Before installing this software or any other software recommended or 
approved by Anritsu, run a virus scan on your computer, including 
removable media (e.g. USB memory stick and CF memory card) you 
want to connect to your computer. 
 
When using this software and connecting with the measuring instrument 
• Copying files and data 

On your computer, do not save any copies other than the following: 
 • Files and data provided by Anritsu 
 • Files created by this software 
 • Files specified in this document 

Before copying these files and/or data, run a virus scan, including 
removable media (e.g. USB memory stick and CF memory card). 

• Connecting to network 
Connect your computer to the network that provides adequate 
protection against computer viruses. 

 
 
 

Cautions on Proper Operation of Software 

This software may not operate normally if any of the following operations 
are performed on your computer: 
• Simultaneously running any software other than that recommended or 

approved by Anritsu 
• Closing the lid (Laptop computer) 
• Turning on the screen saver function 
• Turning on the battery-power saving function (Laptop computer) 
For how to turn off the functions, refer to the operation manual that came 
with your computer. 
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CE Conformity Marking 
Anritsu affixes the CE conformity marking on the following product(s) in 
accordance with the Council Directive 93/68/EEC to indicate that they 
conform to the EMC and LVD directive of the European Union (EU). 
 

CE marking 

 

1. Product Model 
Software: MX370112A/MX269912A TD-SCDMA IQproducerTM 

 
2. Applied Directive and Standards 
 When the MX370112A/MX269912A TD-SCDMA IQproducerTM is installed 

in the MG3710A, MS2690A/MS2691A/MS2692A, or MS2830A, the 
applied directive and standards of this software conform to those of the 
MG3710A, MS2690A/MS2691A/MS2692A, or MS2830A main frame. 

 
 PS: About main frame 
 Please contact Anritsu for the latest information on the main frame 

types that MX370112A/MX269912A can be used with. 
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C-tick Conformity Marking 
Anritsu affixes the C-tick mark on the following product(s) in accordance with 
the regulation to indicate that they conform to the EMC framework of 
Australia/New Zealand. 
 

C-tick marking 

 

 
1. Product Model 

Software: MX370112A/MX269912A TD-SCDMA IQproducerTM 
 
2. Applied Directive and Standards 
 When the MX370112A/MX269912A TD-SCDMA IQproducerTM is installed 

in the MG3710A, MS2690A/MS2691A/MS2692A, or MS2830A, the 
applied directive and standards of this software conform to those of the 
MG3710A, MS2690A/MS2691A/MS2692A, or MS2830A main frame. 

 
 PS: About main frame 
 Please contact Anritsu for the latest information on the main frame 

types that MX370112A/MX269912A can be used with. 
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About This Manual 

■Associated Documents 

The operation manual configuration of the MX370112A/MX269912A 
TD-SCDMA IQproducerTM is shown below.  

■If using MG3700A or MG3710A:  

Or 

 

MX370112A/MX269912A  
TD-SCDMA IQproducer™ Operation Manual  

MG3700A /MG3710A Vector Signal Generator  
MG3740A Analog Signal Generator Operation Manual (IQproducer™) 

MG3700A  
Vector Signal Generator  
Operation Manual (Mainframe) 

MG3710A Vector Signal Generator 
MG3740A Analog Signal Generator  
Operation Manual (Mainframe) 

 

 MG3700A Vector Signal Generator Operation Manual (Mainframe) 

This describes basic operations, maintenance procedure, and remote 
functions of the MG3700A Vector Signal Generator.  

 Or 

 MG3710A Vector Signal Generator MG3740A Analog Signal Generator 

Operation Manual (Mainframe) 

This describes basic operations, maintenance procedure, and remote 
functions of the MG3710A Vector Signal Generator and the MG3740A 
Analog Signal Generator .  

 

 MG3700A/MG3710A Vector Signal Generator MG3740A Analog Signal 

Generator Operation Manual (IQproducer™) 

This describes the functions and how to use the IQproducer, which is 
Windows software for the Vector Signal Generator and the Analog Signal 
Generator . 
 

 TD-SCDMA IQproducer™ Operation Manual (This document) 

This describes basic operations and functions of the TD-SCDMA IQpro-
ducerTM.  
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■If using MS2690A/MS2691A/MS2692A or MS2830A:  

MX370112A/MX269912A  
TD-SCDMA IQproducer™ Operation Manual 

 

MS2690A/MS2691A/MS2692A 
Signal Analyzer Operation Manual 
(Main Frame Operation) 

MS2690A/MS2691A/MS2692A and MS2830A  
Signal Analyzer Operation Manual (Main Frame Remote Control) 

MS2830A Signal Analyzer 
Operation Manual  
(Main Frame Operation) Or 

MS2690A/MS2691A/MS2692A 
Signal Analyzer Option 020:  
Vector Signal Generator  
Operation Manual  
(Operation) 

MS2830A 
Signal Analyzer 
Vector Signal Generator 
Operation Manual  
(Operation) 

Or 

MS2690A/MS2691A/MS2692A 
Signal Analyzer Option 020: 
Vector Signal Generator 
Operation Manual 
(Remote Control) 

MS2830A Signal Analyzer  
Vector Signal Generator 
Operation Manual  
(Remote Control) Or 

MS2690A/MS2691A/MS2692A and MS2830A 
Vector Signal Generator Operation Manual (IQproducer™)
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 MS2690A/MS2691A/MS2692A Signal Analyzer Operation Manual (Main-

frame, Operation) 

This describes basic operations, maintenance procedure, common func-
tions and common remote functions of the MS2690A/MS2691A/MS2692A.  

Or 

 MS2830A Signal Analyzer Operation Manual (Mainframe, Operation) 

This describes basic operations, maintenance procedure, common func-
tions and common remote functions of the MS2830A.  
---------------------------------------------------------------------------------------------- 

 MS2690A/MS2691A/MS2692A and MS2830A Signal Analyzer Operation 

Manual (Mainframe, Remote Control) 

These describe basic operations, maintenance procedure, common func-
tions and common remote functions of the MS2690A/MS2691A/MS2692A 
or MS2830A.  
---------------------------------------------------------------------------------------------- 

 MS2690A/MS2691A/MS2692A Signal Analyzer Option 020: Vector Signal 

Generator Operation Manual, Operation 

This describes the functions and how to use the Vector Signal Generator 
option. 

Or 

 MS2830A Vector Signal Generator Operation Manual, Operation 

This describes the functions and how to use the Vector Signal Generator 
option. 
---------------------------------------------------------------------------------------------- 

 MS2690A/MS2691A/MS2692A Signal Analyzer Option 020: Vector Signal 

Generator Operation Manual, Remote Control 

This describes how to remotely control the Vector Signal Generator op-
tion.  

Or 

 MS2830A Vector Signal Generator Operation Manual, Remote Control 

This describes how to remotely control the Vector Signal Generator op-
tion. 
---------------------------------------------------------------------------------------------- 

 MS2690A/MS2691A/MS2692A and MS2830A Vector Signal Generator 

Operation Manual (IQproducer™) 

This describes the functions and how to use the IQproducer, which is 
Windows software for the Vector Signal Generator option. 
---------------------------------------------------------------------------------------------- 

 TD-SCDMA IQproducer™ Operation Manual (This document) 

This describes basic operations and functions of the TD-SCDMA IQpro-
ducer™.  
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This chapter provides an overview of the MX370112A/MX269912A 
TD-SCDMA IQproducer. 

 

1.1 Product overview .......................................................... 1-2 
1.2 Product Composition .................................................... 1-3 
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1.1 Product overview 
The MX370112A/MX269912A TD-SCDMA IQproducer™ software 
(hereafter this software) is software used to generate waveform patterns 
conforming to the 3GPP TD-SCDMA specifications. This software refers 
to the following 3GPP specifications.  

• TS 25.221 V10.0.0 (2010-12) 
• TS 25.222 V10.1.0 (2011-03) 
• TS 25.223 V10.0.0 (2010-12) 
• TS 25.105 V7.9.0 (2008-05) 
• TS 25.142 V8.0.0 (2008-05) 
  
This software requires either of the following environment: 

• MG3710A Vector Signal Generator 
• MS2690A/MS2691A/MS2692A or MS2830A Signal Analyzer with 

Vector Signal Generator option mounted 
• Personal computer (hereinafter, “PC”) 
 
This software generates waveform patterns that support the 
specifications of 3GPP TD-SCDMA with various characteristics. This is 
made possible by the editing/customizing of parameters according to its 
use.  

A waveform pattern created by this software can be output using an RF 
signal after being downloaded into the MG3700A Vector Signal 
Generator ,MG3710A Vector Signal Generator , or an 
MS2690A/MS2691A/MS2692A or MS2830A Signal Analyzer with Vector 
Signal Generator option installed (collectively referred to as “mainframe”, 
or “this equipment”).  
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1.2 Product Composition 
The following table lists the model name and specifications of this 
software according to the equipment. 

Table 1.2-1  Restrictions 

Mainframe 

 

Restrictions 

MG3700A MG3710A 
MS2690A 
MS2691A 
MS2692A 

MS2830A 

Software name MX370112A MX269912A 

Maximum Size 
of Waveform 
Patterns 

256 M sample 
512 M sample*1 

64 M sample 
128 M sample*5 
256 M sample*6 
512 M sample*7 

256 M sample 64 M sample 
256 M sample*4 

Transmission 
method of 
Waveform 
Patterns 

LAN, 
CompactFlash 
Card 

External device 
such as LAN, 
USB memory*2 

USB Memory 
and other 
external device *2 

USB Memory 
and other 
external device *2 

Installation of 
this software 
to this 
equipment 

N/A Possible  Possible *3 Possible *3 

 
*1: The ARB memory expansion 512M sample (optional) must be 

installed into the MG3700A to use waveform patterns that exceed 
256M samples. 

*2: Transferring waveform patterns is not required if the waveform 
patterns are created on the equipment using this software. 

*3: Although this software can be installed and run in the 
MS2690A/MS2691A/MS2692A or MS2830A, the measurement 
functions of the MS2690A/MS2691A/MS2692A or MS2830A are not 
guaranteed while this software runs. 

*4: The ARB memory expansion 256M sample (optional) must be 
installed into the Vector Signal Generator option to use waveform 
patterns that exceed 64 M samples.  

*5: The Combination of Baseband Signal (optional) must be installed 
into the MG3710A to use waveform patterns of maximum 128 M 
samples. 

*6: The ARB memory expansion 256M sample (optional) must be 
installed into the MG3710A to use waveform patterns of maximum 
256 M samples.  
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*7: To use waveform patterns of maximum 512 M samples, either of the 
following must be installed into MG3710A: 

• ARB memory expansion 1024 M sample (optional) 

• ARB memory expansion 256 M (optional) and Combination of 
Baseband Signal (optional) 

 

■Notes on waveform pattern conversion 

The waveform patterns generated with this software varies according to 
the main unit type. If using the waveform pattern to the different main 
unit, you need to convert the waveform pattern.  

For details about how to convert a waveform pattern, refer to each one of 
the following manuals.  

• MG3700A/MG3710A Vector Signal Generator MG3740A Analog 
Signal Generator Operation Manual (IQproducer™) 
4.5 “File Conversion on Convert Screen” 

• MS2690A/MS2691A/MS2692A and MS2830A Vector Signal Generator 
Operation Manual (IQproducer™) 
4.5 “File Conversion on Convert Screen”  
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This chapter describes the operating environment for the 
MX370112A/MX269912A. 

 

2.1 Operating Environment ................................................. 2-2 
2.2 Installation/Uninstallation .............................................. 2-3 
2.3 Starting up and exiting the software ............................. 2-4 

2.3.1 Starting Software: When installed  

on other than MG3710A ................................... 2-4 
2.3.3 Starting Software: When installed  

on MG3710A .................................................... 2-6 
2.3.4 Exiting Software ................................................ 2-7 
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2.1 Operating Environment 
The following environment is required for operating the 
MX370112A/MX269912A. 

(1) PC that meets the following conditions 

OS Windows XP/Windows Vista/Windows 7 
CPU Pentium III 1 GHz equivalent or faster 
Memory 512 MB or more 

Hard disk space 

5 GB or more free space in the drive where 
this software is to be installed.  
The free hard disk space necessary to create 
waveform pattern varies depending on the 
waveform pattern size. The free disk space of 
27 GB or greater is required to create four 
maximum (512 Msample) waveform patterns. 

 
(2) If viewing on PC, displays with a resolution of 1024 × 768 pixels are 

best viewed using a small font setting. 
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2.2 Installation/Uninstallation 
This software is included in the IQproducer™ installer. It is 
automatically installed by installing the IQproducer™ that is supplied 
with this equipment or this software. When using a waveform pattern 
created using this software in the equipment, the license file must be 
installed in advance. 

■Installing/Uninstalling IQproducer™ 

For how to install and uninstall IQproducer™, refer to each of the 
following manuals:  

 MG3700A/MG3710A Vector Signal Generator MG3740A Analog 
Signal Generator Operation Manual (IQproducer™) 
Chapter 2 “Installation” 

 MS2690A/MS2691A/MS2692A and MS2830A Vector Signal Generator 
Operation Manual (IQproducer™) 
Chapter 2 “Installation” 

 

■Installing/Uninstalling IQproducer™ license file 

For how to install license file to MG3700A/MG3710A, refer to the 
following manual:  

 MG3700A/MG3710A Vector Signal Generator MG3740A Analog 
Signal Generator Operation Manual (IQproducer™) 
5.1 “Installing License File” 
 

For how to uninstall license file from MG3700A/MG3710A, refer to each 
one of the following manuals:  

 MG3700A Vector Signal Generator Operation Manual (Mainframe) 
3.10.10 “Install” 

 MG3710A Vector Signal Generator MG3740A Analog Signal 
Generator Operation Manual (Mainframe) 
9.4.4 “Install” 

 
Refer to the following manual for details of how to install/uninstall 
license file to MS2690A/MS2691A/MS2692A or MS2830A with Vector 
Signal Generator option.  

 MS2690A/MS2691A/MS2692A and MS2830A Vector Signal Generator 
Operation Manual (IQproducer™) 
2.2 “Installation/Uninstallation” 
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2.3 Starting up and exiting the software 
This section explains how to start and stop this software. 

Note: 

The following explanation assumes the use of Windows XP. The 
screen image may differ slightly if not using Windows XP. 

2.3.1 Starting Software: When installed on other than MG3710A 
Start this software using the following procedure.  
The example assumes that it is a PC operation.  

<Procedure> 

1. Click Start on the task bar, and point to All Programs. Next, point to 
Anritsu Corporation, point to IQproducer, and then click 
IQproducer. 

2. When IQproducer™ starts, the Select instrument screen is 
displayed. 

On the Select instrument screen, select the model of the main unit 
that uses the waveform patterns created by IQproducer™.  

Notes: 

 This software does not support MG3740A. 

 To hide this screen and to start with the selected mainframe's 
screen from the next time, select the Don't show this window 
next time check box. 
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3. The common platform screen is displayed when OK is clicked in the 
Select instrument screen.  

The common platform screen is a screen used to select each function 
of the IQproducer™.  

 

 

Figure 2.3.1-1  Common Platform Screen 

 

4. Click the System (Cellular) tab on the common platform screen, to 
show the System (Cellular) selection screen that supports each 
telecommunication system.  

 

 

Figure 2.3.1-2  System (Cellular) Selection Screen 

 

5. Click TD-SCDMA to display the main screen. For details of the main 
screen, refer to Chapter 3 “Detailed Description of Functions”.  

Note: 

If Change Instrument is clicked, the Select instrument screen will 
appear each time the software is loaded.  
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2.3.2 Starting Software: When installed on MG3710A 
Start this software using the following procedure.  

<Procedure> 

1. Press  on the MG3710A front panel to display the common 
platform screen.  

The common platform screen is a screen used to select each function 
of the IQproducer™.  

 

Figure 2.3.2-1  Common Platform Screen 

 

2. Click the System (Cellular) tab on the common platform screen, to 
show the System (Cellular) selection screen that supports each 
telecommunication system.  

 

Figure 2.3.2-2  System (Cellular) Selection Screen 
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3. Click TD-SCDMA to display the main screen. For details of the main 
screen, refer to Chapter 3 “Detailed Description of Functions”.  

Note: 

When this software is installed on MG3710A, Change Instrument 
displays instead of Interface Settings. Clicking Interface Settings 
displays the Interface Setting dialog box.  

 

Figure 2.3.2-3  Interface Settings Dialog Box 

 

Here, you can configure interface-related settings of IQproducer 
and MG3710A. To return to factory defaults, click Default.  

 Row Socket Port Number 

Sets Row Socket port number. Set the same value as that for 
MG3710A.  

 Wait Time 

Sets the wait time between commands.  

2.3.3 Exiting Software 
Stop this software using the following procedure. 
■When exiting only this software 
To exit only this software without closing the Common Platform screen, 
or other IQproducer™ tools, do one of these below: 

 Click the Exit button ( ) on the tool bar. 

 Select Exit from the File menu. 

 Click the  button on the upper right screen. 

 

Figure 2.3.3-1  Exiting Software 
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The operation of the three screen buttons is explained below.  

 

 

Figure 2.3.3-2  Exit Confirmation Window 

 

 Yes Saves current parameters to file and stops this 
software. 

 No Stops this software without saving current 
parameters to file. 

 Cancel or  Cancels the process and returns to the main screen. 
 
When stopping this software using the Yes button, the saved parameters 
are read at the next start and reset for each parameter.  

■When exiting entire IQproducer™ application 

To exit all tools of IQproducer™ that are running, select Exit on the 
Common Platform Screen. In this case, a dialog is displayed to confirm 
stopping of each running tool.  

 

Figure 2.3.3-3  Exiting IQproducer™ 
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This chapter provides detailed descriptions of this software.  

Notes: 

 The examples and screens used throughout this chapter are 
based on the assumption that the IQproducer™ is activated 
with the MG3700A.  

 The MG3710A, MS2690A/MS2691A/MS2692A, and MS2830A 
functions are described as notes in each item.  
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3.1 Screen Details 
3.1.1 Menu and tool buttons 

On common platform screen, click the System (Cellular) tab, and then 
select TD-SCDMA to display the main screen.  

 
(1) 

(2) 

(3) 

 

Figure 3.1.1-1  TD-SCDMA Main Screen  

 

(1) Menu bar Opens File, Edit, Transfer & Setting, Simulation 
menus.  

(2) Tool Bar Displays the icons corresponding to the same 
functions as the menu items.  

(3) Parameter setting   

  Common Setting, Carrier Setting, and Pattern 
Setting parameters can be set here.  

 

Note: 

When this software is running on MG3710A, the Calculation 
button in the Pattern Setting field changes to Calculation, and the 
Exit button changes to Calculation & Play, respectively.  
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■ Basic operation of the main screen 

The main screen operates as described below when this software is 
running on equipment other than MG3710A.  

 The window size can be minimized or maximized.  

 If the tool bar is omitted due to the reduced window, the omitted 
toolbar is indicated as a symbol.  

 The items in italic cannot be changed. These items are 
automatically set. The state of an item can be changed depending 
on the setting of other items.  

 The items indicated in gray characters are parameters independent 
of waveform patterns generated at that time, and therefore cannot 
be changed. However, their states can be changed depending on the 
setting of other items.  
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■ Screen transition 

Figure 3.1.1-2 shows transition from the main screen that is displayed 
when the TD-SCDMA IQproducer™ is started up to other screens 
(Export File, Calculation, and Sub-frame Structure screens). For the 
details of each screen, refer to the description under the relevant screen.  

 

OK 

Main screen 

Cancel

Calculation 

OK: after 
calculation 

Cancel 

Close 
Sub-frame  
Structure 
screen 

Click 
Sub-frame  
Structure 

display button

Export File screen  
(Refer to 3.1.7 “Export File 
screen”) 

Sub-frame Structure screen  
(Refer to 3.1.6 “Sub-frame Structure screen”) 

Calculation screen  
(Refer to 3.1.8 “Calculation 
screen”) 

Calculation & Play

Calculation & Load

 

Figure 3.1.1-2  Screen Transition 

 

Note: 

When this software is running on MG3710A, the Calculation 
button in the Pattern Setting field changes to Calculation & Load, 
and the Exit button changes to Calculation & Play, respectively.  
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■File menu 

 

Figure 3.1.1-3  File menu 

 

 Select Option 

 

Notes: 

 This function is available only when MG3700, MG3710 or 
MS2830 is selected in the Select instrument screen. 

 ARB Memory Expansion (option) is not available for MS269xA. 
Only Memory 256M samples, 1 GB is available.  

■ When using MG3700A or MS2830A 

 Select whether the ARB memory expansion option 256Msamples is 
installed. Selecting With Option21 (Memory 512M samples)/With 
Option27 (Memory 256M samples) supports creation of larger 
waveform patterns. If the ARB memory expansion option is not 
installed, the generated waveform pattern may not be able to be 
used. Waveform patterns cannot be created with a size greater than 
256Msamples or 64M samples when Without Option21 (Memory 
512M samples)/Without Option27 (Memory 256M samples) is 
selected. Select either according to the presence of ARB memory 
expansion option. 

Table 3.1.1-1  Available Options for MG3700A or MS2830A 

Model Items 
ARB Memory 

Expansion 

MG3700A 

With Option21 (Memory 512M 
samples) 

1 GB x 2 
memory 

Without Option21 (Memory 
512M samples): 

512 MB × 2 
Memories 

MS2830A 

With Option27 (Memory 256M 
samples) 1 GB 

Without Option27 (Memory 
256M samples) 256 MB 
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■ When using MG3710A 

 The presence/absence of the ARB Memory Expansion (option) and 
Baseband Signal Combination Function (option) is selected. 
Selecting the ARB Memory Expansion (option) and the Baseband 
Signal Combination Function (option) generates a bigger waveform 
pattern, while selecting the Baseband Signal Combination Function 
(option) generates a waveform pattern. If an uninstalled option is 
selected, sometimes the created waveform pattern may not be 
usable.  

 Set the combination of installed options based on the following 
setting items.  

Table 3.1.1-2  Available Options for MG3710A 

Items Combinations of Options 

Memory 64M samples None 

Memory 64M samples × 2 
Option48 
and 
Option 78 

Memory 256M samples 
Option45 
or 
Option 75 

Memory 256M samples × 2 
Option 45 and Option 48 
or 
Option 75 and Option 78 

Memory 1024M samples 
Option46 
or 
Option 76 

Memory 1024M samples × 2 
Option 46 and Option 48 
or 
Option 76 and Option 78 

The maximum size of the generated waveform pattern for each of 
the setting items is shown below.  

Table 3.1.1-3  Waveform Pattern Maximum Size 

Items Maximum Size 

Memory 64M samples 64M samples 
Memory 64M samples × 2 (With 
Option48, 78) 128M samples 

Memory 256M samples 256M samples 
Memory 256M samples × 2 (With 
Option48, 78) 512M samples 

Memory 1024M samples 512M samples 
Memory 1024M samples × 2 (With 
Option48, 78) 512M samples 
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 Recall Parameter File 

Recalls the parameter file that has been saved with Save 
Parameter File. Once the parameter files is recalled, the settings 
that were valid when the parameter file was saved are restored.  
Refer to 3.3 “Saving/reading parameters” for details.  

 Save Parameter File 

Saves the current settings in the parameter file.  
Refer to 3.3 “Saving/reading parameters” for details. 

 Exit 

Exits the IQproducerTM.  

 
■Edit menu 

 

Figure 3.1.1-4  Edit menu 

 

 Calculation  
Performs waveform pattern generation.  
Refer to 3.1.7 “Export File screen” for details. 

 Calculation & Load  

Note: 

This function is available only when this software is used on 
MG3710A. 

After waveform generation is finished, the created waveform 
pattern is loaded into the MG3710A waveform memory.  

 

 Calculation & Play  

Note: 

This function is available only when this software is used on 
MG3710A. 

After waveform generation is finished, the created waveform 
pattern is loaded and selected at the MG3710A waveform memory.  
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 Show Sub frame Structure 

Starts Sub-frame Structure screen.  
Refer to 3.1.6 “Sub-frame Structure screen” for details.  

 Clipping 

Displays the Clipping screen. In this screen, clipping and filtering 
processing can be performed for a generated waveform pattern.  

 Copy Carrier#1 To All 

Copies the settings of Carrier#1 to all other carriers.  

 

■Transfer & Setting menu 

 

Figure 3.1.1-5  Transfer & Setting Menu 

 

 Transfer & Setting Wizard 

Note: 

This function is available only when MG3700 or MG3710 is 
selected in the Select instrument screen.  

The Transfer & Setting Wizard screen is displayed. This screen is 
used to connect a PC to MG3700A/MG3710A, transfer waveform 
patterns to MG3700A/MG3710A, and generate waveform patterns 
in a desired waveform memory of MG3700A/MG3710A.  

 
■Simulation menu 

 

Figure 3.1.1-6  Simulation Menu 

 

 CCDF 

Displays the CCDF Graph Monitor screen. The CCDF of a 
generated waveform pattern is displayed in a graph.  

 FFT 

Displays the FFT Graph Monitor screen. The spectrum where FFT 
processing is performed for a generated waveform pattern is 
displayed in a graph.  
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 Time Domain 

Displays the Time Domain screen. In this screen, the time domain 
waveform of a generated waveform pattern is displayed in a graph.  

 

■Tool Bar 

Notes: 

 Transfer&Setting Wizard is available only when MG3700 or 
MG3710 is selected in the Select instrument screen.  

 Calculation & Load and Calculation & Play are available 
only when this software is used on MG3710A. 

  

  Recall Parameter File 

  Save Parameter File 

  Calculation 

  Calculation & Load 

  Calculation & Play 

 Transfer & Setting Wizard 

 CCDF 

 FFT 

 Time Domain 

 Clipping 

  Sub-frame Structure 

  Exit 

 

Clicking a tool button operates the same as the corresponding commands 
in the menu.  
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3.1.2 Common Setting 
The parameters of this software are divided into three: Common Setting, 
Carrier Setting, and Pattern Setting.  
The Carrier Setting tabs are displayed correspond to the value set by 
Number of Carriers in Common Setting.  

Number of sub-frames 

[Overview] Sets the number of sub-frames.  

[Default] 1 
[Setting range] See the table below 

Table 3.1.2-1  Number Of Sub-Frames (Upper Limit) 

Instru- 
ment 

Number of 
Carriers 

Select Option 

MG3700 

Memory 
Option 

Without 
Option 21(Memory 512Msamples) 

With 
Option 21(Memory 512Msamples) 

1 10485 20971 

2 5242 10485 

3 to 6 2621 5242 

MS269x 

Memory 256 Msamples --- 

1 10485 --- 

2 5242 --- 

3 to 6 2621 --- 

MS2830 

Memory 
Option 

Without 
Option 27 (Memory 256Msamples) 

With 
Option 27 (Memory 256Msamples) 

1 2621 10485 

2 1310 5242 

3 to 6 655 2621 

MG3710 

Memory 
Option 

Without 
Memory Option 

With 
Option 45, 75 

With 
Option 46, 76 

Combination 
of Baseband 
Signal Option

Without 
Option 
48, 78 

With 
Option 
48, 78 

Without 
Option 
48, 78 

With 
Option 
48, 78 

Without 
Option 
48, 78 

With 
Option 
48, 78 

Memory 
64 M 
samples 

64 M 
samples × 
2 

256 M 
samples 

256 M 
samples × 
2 

1024 M 
samples 

1024 M 
samples × 
2 

1 2621 5242 10485 20971 20971 20971 

2 1310 2621 5242 10485 10485 10485 

3 to 6 655 1310 2621 5242 5242 5242 
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Link 

[Overview] Sets DL or UL.  
[Default] UL 
[Options] UL, DL 
[Remarks] When the setting is changed, all the parameters associated with 

Channel Setting are initialized.  
 
Number of Carriers 

[Overview] Sets number of carriers.  
[Default] 1 
[Setting range] 1 to 6 
[Remarks] The upper limits of Number of sub-frames are different 

between when the number of carriers is less than four 
and when it is four or more.  

 
Adjust Carrier Power 

[Overview] Adjusts Relative Power of each Carrier so that the 
maximum value of Relative Power is 0.00 dB.  

 
Adjust Code Power 

[Overview] Adjusts each Carrier so that the maximum value of the 
channel Power is 0.00 dB.  
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3.1.3 Carrier Setting  
The Carrier Setting tabs are displayed correspond to the value set by 
Number of Carriers in Common Setting. The same parameters are 
displayed regardless of selected Carrier tab.  

Frequency Offset 

[Overview] Sets carrier frequency offset.  
[Default] 0 
[Options] –4.0, –3.2, –2.4, –1.6, –0.8, 0, +0.8, +1.6, +2.4, +3.2, +4.0 
[Unit] MHz 
[Remarks] The frequency offset range of selectable carrier varies 

according to the setting of Number of Carriers.  
 

Relative Power 

[Overview] Sets the level ratio of selected carrier.  
[Default] 0.00 dB 
[Setting range] –40.00 to 0.00 dB, setting resolution: 0.01 dB 
 
Channel Coding 

[Overview] Enables/disables channel coding.  
[Default] Link = DL: OFF 
  Link = UL: ON 
[Setting range] This parameter is fixed and cannot be altered.  
 
Switching Point 

[Overview] Sets a Switching Point position (switching timing 
between DL and UL).  

[Default] 3 
[Setting range] 1 to 6 (This is set after Time Slot with the same value.)  
[Remarks] When Link is DL, a value beyond Time Slot (later in time) 

where Channel is already allocated cannot be set to 
Switching Point.  

 When Link is UL, a value smaller than Time Slot (earlier 
in time) where Chanel is already allocated cannot be set 
to Switching Point.  

 
Scrambling Code 

[Overview] Sets the scrambling code. 
[Default] 0 
[Setting range] 0 to 127 
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Midamble Config 

[Overview]  Displays the Midamble Config.  
[Default] Default 
[Options] Default, Common, UE Specification 
[Remarks]  You cannot select Common when Link is UL.  
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3.1.4 Channel Setting  
Click Channel Setting to edit downlink channel (when DL is set for Link 
under Common Setting) or uplink channel (when UL is set for Link 
under Common Setting), respectively. Both downlink/uplink channel can 
be configured for each carrier. In Channel Setting tab, click OK to apply 
the edited parameter. Click Cancel to discard the change and close the 
screen.  

 

 

Figure 3.1.4-1  Channel Setting (Link = DL)  

 

 

 

Figure 3.1.4-2  Channel Setting (Link = UL)  
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3.1.4.1 When Link is DL 

In the Common Setting dialog box, the following tabs are displayed when 
DL is set for Link.  

 P-CCPCH 

 S-CCPCH 

 DwPCH 

 PDSCH 

 PICH 

 DPCH 

 HS-PDSCH 

 HS-SCCH 
What follows below is the breakdown of each setting item.  

Note: 

Note that some setting items cannot be configured in relation to 
other channels’ settings.  

P-CCPCH 

When P-CCPCH tab is selected, the following items will be displayed.  

State 

[Overview] Turns On/Off the channel.  
[Default] ON 
[Options] ON, OFF 
[Remarks]  Parameter other than State cannot be set when State is 

OFF.  
 

Power 

[Overview]  Sets channel power.  
[Default] 0.00 dB 
[Setting range] –40.00 to 0.00 dB, Resolution 0.01 dB 

 

Time Slot 

[Overview] Displays the position of Time Slot to be allocated.  
[Default] 0 
[Setting range] 0 
 
Slot Format 

[Overview] Displays the slot format.  
[Default] 16 
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Channel Code 

[Overview] Displays the Channelization Code.  
[Default] 1 
 
Data Type 

[Overview]  Sets the data type to be mapped to channel.  
[Default] PN9 
[Options] PN9, PN15, All0, All1, User File 
[Remarks] The default pattern values of PN9 and PN15 are same in 

a given channel, but they are different channel by 
channel.  

 

Block Size 

[Overview] Displays the block size of information data.  
[Default] 246 
 

CRC Size 

[Overview] Displays the CRC size (bit count) to add to Information 
Data.  

[Default] 16 bits 
 
Coding Type 

[Overview] Displays the channel coding type.  
[Default] Convolution-1/3 
 

Rate Matching Attribute 

[Overview] Displays the Rate Matching attribute.  
[Default] 256 
 
TFCI 

[Overview] Displays the TFCI (Transport Format Combination 
Indicator).  

[Remarks] There is no TFCI value of P-CCPCH.  
 
TPC 

[Overview] Displays the TPC (Transmitter Power Control).  
[Remarks] There is no TPC value of P-CCPCH.  
 

SS 

[Overview] Displays the synchronization shift parameter.  
[Remarks] There is no SS value of P-CCPCH.  
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Midamble K 

[Overview] Sets the Midamble K value.  
[Default] 8 
[Options] 2, 4, 6, 8, 10, 12, 14, 16 
 
UE spec shift 

[Overview] Sets the UE spec shift value.  
[Default] 8 
[Setting range] 1 to Midamble K 
[Remarks] Available only when UE specification is selected for 

Midamble Config of Carrier Setting.  
 

SF 

[Overview] Displays the spreading factor.  
[Default] 16 
 

S-CCPCH 

When S-CCPCH tab is selected, the following items will be displayed.  

State 

[Overview] Turns On/Off the channel.  
[Default] OFF 
[Options] ON, OFF 
[Remarks]  Parameter other than State cannot be set when State is 

OFF.  
 

Power 

[Overview]  Sets channel power.  
[Default] 0.00 dB 
[Setting range] –40.00 to 0.00 dB, Resolution 0.01 dB 

 

Time Slot 

[Overview] Sets the position of Time Slot to be allocated.  
[Default] 0  
[Setting range] 0, 2 to 6 
[Remarks] The location of placeable Time Slot changes according to 

Switching Point setting.  
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Data Type 

[Overview]  Sets the data type to be mapped to channel.  
[Default] PN9 
[Options] PN9, PN15, All0, All1, User File 
[Remarks] The default pattern values of PN9 and PN15 are same in 

a given channel, but they are different channel by 
channel.  

 
Channel Code 

[Overview] Sets the Channelization Code.  
[Default] 3 
[Setting range] 1 to 15 
 
Slot Format 

[Overview] Sets the slot format.  
[Default] 0 
[Setting range] 0 to 9 
 
TFCI 

[Overview] Sets the TFCI (Transport Format Combination Indicator).  
[Default] 0 
[Setting range] 0 to 1023 
[Remarks] The setting range changes according to the Slot Format.  
 
TPC 

[Overview] Sets the TPC (Transmitter Power Control).  
[Default] All 0 
[Options] Repeat 101010, Repeat 010101, All 0, All 1, User File 
[Remarks] Available when the Slot Format is 5 to 9.  
 

SS 

[Overview] Sets the synchronization shift parameter.  
[Default] All 0 
[Options] Repeat 101010, Repeat 010101, All 0, All 1, User File 
[Remarks] Available when the Slot Format is 5 to 9.  
 
SF 

[Overview] Displays the spreading factor.  
[Default] 16 
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Block Size 

[Overview] Sets the block size of information data.  
[Default] 246 
[Setting range] 1 to 5000 
 
CRC Size 

[Overview] Sets the CRC size (bit count) to add to Information Data.  
[Default] 16 bits 
[Options] 8bits, 12bits, 16bits, 24bits 
 
Coding Type 

[Overview] Sets the channel coding type.  
[Default] Convolution-1/3 
[Options] Convolution-1/2, Convolution-1/3, Turbo-1/3 
 
Rate Matching Attribute 

[Overview] Displays the Rate Matching attribute.  
[Default] 256 
 
Midamble K 

[Overview] Sets the Midamble K value.  
[Default] 8 
[Options] 2, 4, 6, 8, 10, 12, 14, 16 
 
UE spec shift 

[Overview] Sets the UE spec shift value.  
[Default] 8 
[Setting range] 1 to Midamble K 
[Remarks] Available only when UE specification is selected for 

Midamble Config of Carrier Setting.  
 

DwPCH 

When DwPCH tab is selected, the following items will be displayed.  

State 

[Overview] Turns On/Off the channel.  
[Default] ON 
[Options] ON, OFF 
[Remarks]  Parameter other than State cannot be set when State is 

OFF.  
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Power 

[Overview]  Sets channel power.  
[Default] 0.00 dB 
[Setting range] –40.00 to 0.00 dB, Resolution 0.01 dB 

 

Sync-DL code 

[Overview] Displays the SYNC code at Downlink .  
[Remarks] It is auto-calculated from the Scrambling Code of Carrier 

Setting.  
 

PDSCH 

When PDSCH tab is selected, the following items will be displayed.  

State 

[Overview] Turns On/Off the channel.  
[Default] OFF 
[Options] ON, OFF 
[Remarks]  Parameter other than State cannot be set when State is 

OFF.  
 
Power 

[Overview]  Sets channel power.  
[Default] 0.00 dB 
[Setting range] –40.00 to 0.00 dB, Resolution 0.01 dB 
 
Time Slot 

[Overview] Sets the position of Time Slot to be allocated.  
[Default] 0 
[Setting range] 0, 2 to 6 
[Remarks] The location of placeable Time Slot changes according to 

Switching Point setting.  
 
Data Type 

[Overview] Sets the data type to be mapped to channel.  
[Default] PN9 
[Options] PN9, PN15, All0, All1, User File 
[Remarks] The default pattern values of PN9 and PN15 are same in 

a given channel, but they are different channel by 
channel.  
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Channel Code 

[Overview] Sets the Channelization Code.  
[Default] 1 
[Setting range] 1 to SF 
 
Slot Format 

[Overview] Sets the slot format.  
[Default] 0 
[Setting range] 0 to 24 
 
TFCI 

[Overview] Sets the TFCI (Transport Format Combination Indicator).  
[Default] 0 
[Setting range] 0 to 1023 
[Remarks] The setting range changes according to the Slot Format.  
 
TPC 

[Overview] Sets the TPC (Transmitter Power Control).  
[Default] All 0 
[Options] Repeat 101010, Repeat 010101, All 0, All 1, User File 
[Remarks] Available when the Slot Format is 5 to 9 or 15 to 24.  
 

SS 

[Overview] Sets the synchronization shift parameter.  
[Default] All 0 
[Options] Repeat 101010, Repeat 010101, All 0, All 1, User File 
[Remarks] Available when the Slot Format is 5 to 9 or 15 to 24.  
 
SF 

[Overview] Displays the spreading factor.  
[Default] 1, 16 
[Remarks] SF is automatically set according to the Slot Format when 

the Channel Coding is ON. 
 
Block Size 

[Overview] Sets the block size of information data.  
[Default] 246 
[Setting range] 1 to 5000 
 
CRC Size 

[Overview] Sets the CRC size (bit count) to add to Information Data.  
[Default] 16bits 
[Options] 8bits, 12bits, 16bits, 24bits 
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Coding Type 

[Overview] Sets the channel coding type.  
[Default] Convolution-1/3 
[Options] Convolution-1/2, Convolution-1/3, Turbo-1/3 
 
Rate Matching Attribute 

[Overview] Displays the Rate Matching attribute.  
[Default] 256 
 
Midamble K 

[Overview] Sets the Midamble K value.  
[Default] 16 
[Options] 2, 4, 6, 8, 10, 12, 14, 16 
 
UE spec shift 

[Overview] Sets the UE spec shift value.  
[Default] 16 
[Setting range] 1 to Midamble K 
[Remarks] Available only when UE specification is selected for 

Midamble Config of Carrier Setting.  
 

PICH 

When PICH tab is selected, the following items will be displayed.  

State 

[Overview] Turns On/Off the channel.  
[Default] OFF 
[Options] ON, OFF 
[Remarks]  Parameter other than State cannot be set when State is 

OFF.  
 
Power 

[Overview]  Sets channel power.  
[Default] 0.00 dB 
[Setting range] –40.00 to 0.00 dB, Resolution 0.01 dB 

 
Time Slot 

[Overview] Sets the position of Time Slot to be allocated.  
[Default] 6  
[Setting range] 0, 2 to 6 

[Remarks] The location of placeable Time Slot changes according to 
Switching Point setting.  
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Channel Code 

[Overview] Sets the Channelization Code.  
[Default] 1 
[Setting range] 1 to 15 
 
Data Type 

[Overview]  Sets the data type to be mapped to channel.  
[Default] PN9 
[Options] PN9, PN15, All0, All1, User File 
[Remarks] The default pattern values of PN9 and PN15 are same in 

a given channel, but they are different channel by 
channel.  

 

Slot Format 

[Overview] Displays the slot format.  
[Default] 0 
 
Midamble K 

[Overview] Sets the Midamble K value.  
[Default] 16 
[Options] 2, 4, 6, 8, 10, 12, 14, 16 
 
UE spec shift 

[Overview] Sets the UE spec shift value.  
[Default] 16 
[Setting range] 1 to Midamble K 
[Remarks] Available only when UE specification is selected for 

Midamble Config of Carrier Setting.  
 
SF 

[Overview] Displays the spreading factor.  
[Default] 16 
 

DPCH 

When DPCH tab is selected, the following items will be displayed.  

Number of RMC 

[Overview]  Sets the number of RMC.  
[Default] 1 
[Setting range] 1 to 8 
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RMC 

[Overview]  Sets the RMC number, which edits detailed parameter.  
[Default] 1 
[Setting range] 1 to Number of RMC 
 
The following items are displayed for each RMC, and can be configured 
for each RMC.  

 

State 

[Overview] Turns On/Off the channel.  
[Default] ON 
[Options] ON, OFF 
[Remarks]  Parameter other than State of each RMC cannot be set 

when State is OFF.  
 
Power 

[Overview]  Sets channel power.  
[Default] 0.00 dB 
[Setting range] –40.00 to 0.00 dB, Resolution 0.01 dB 

 
RMC Type 

[Overview]  Displays the RMC type.  
[Default] 12.2 kbps 
 

Time Slot 

[Overview] Sets the position of Time Slot to be allocated.  
[Default] Switching Point + 1 
 However, 0 when Switching Point = 6.  
[Setting range] 0, 2 to 6 

[Remarks] The location of placeable Time Slot changes according to 
Switching Point setting.  

 
Channel Code 

[Overview] Sets the Channelization Code.  
[Default] 1 
[Setting range] 1 to SF 
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DTCH Data Type 

[Overview]  Sets the data type to be mapped to channel.  
[Default] PN9 
[Options] PN9, PN15, All0, All1, User File 
[Remarks] The default pattern values of PN9 and PN15 are same in 

a given channel, but they are different channel by 
channel.  

 
DTCH Rate Matching Attribute 

[Overview] Sets the Rate Matching attribute of DTCH.  
[Default] 256 
[Setting range] 0 to 256 
 

DCCH Data Type 

[Overview]  Sets the data type to be mapped to DCCH.  
[Default] PN9 
[Options] PN9, PN15, All0, All1, User File 
[Remarks] The default pattern values of PN9 and PN15 are same in 

a given channel, but they are different channel by 
channel.  

 
DCCH Rate Matching Attribute 

[Overview] Sets the Rate Matching attribute of DCCH.  
[Default] 256 
[Setting range] 0 to 256 
 
SF 

[Overview] Sets the spreading factor.  
[Default] 16 
[Options] 1, 16 
 
TFCI 

[Overview] Sets the TFCI (Transport Format Combination Indicator).  
[Default] 0 
[Setting range] 0 to 31 
 
TPC 

[Overview] Sets the TPC (Transmitter Power Control).  
[Default] All 0 
[Options] Repeat 101010, Repeat 010101, All 0, All 1, User File 
[Remarks] Available when the Slot Format is 5 to 9.  
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SS 

[Overview] Sets the synchronization shift parameter.  
[Default] All 0 
[Options] Repeat 101010, Repeat 010101, All 0, All 1, User File 
[Remarks] Available when the Slot Format is 5 to 9.  
 
Midamble Config 

[Overview]  Displays the Midamble Config.  
[Remarks]  The Midamble Config value set in Carrier Setting will be 

displayed.  
 
Midamble K 

[Overview] Sets the Midamble K value.  
[Default] 16 
[Options] 2, 4, 6, 8, 10, 12, 14, 16 
 
UE spec shift 

[Overview] Sets the UE spec shift value.  
[Default] 16 
[Setting range] 1 to Midamble K 
[Remarks]  Available only when UE specification is selected for 

Midamble Config of Carrier Setting.  

 

Number of DPCH per TS 

[Overview] Sets the number of DPCH per each time slot.  
[Default] 1 
[Setting range] 1 to (SF – Channel Code + 1) 
 
Block Size 

[Overview] Displays the block size of information data.  
[Default] 244 
 

HS-PDSCH 

When HS-PDSCH tab is selected, the following items will be displayed.  

HSPA RMC Type 

[Overview]  Sets the RMC type.  
[Default] RMC 0.5 Mbps 
[Options]  RMC 0.5 Mbps, RMC 1.1 Mbps, RMC 1.6 Mbps,  

RMC 2.2 Mbps, RMC 2.8 Mbps, RMC 48kbps 
[Remarks] RMC 48 kbps is available only when the Number of 

Carriers is 2 or more.  
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State 

[Overview] Turns On/Off the channel.  
[Default] ON 
[Options] ON, OFF 
[Remarks]  Parameter other than State cannot be set when State is 

OFF.  
 
Power 

[Overview]  Sets channel power.  
[Default] 0.00 dB 
[Setting range] –40.00 to 0.00 dB, Resolution 0.01 dB 

 
Time Slot 

[Overview] Sets the position of Time Slot to be allocated.  
[Default] Time Slot with the smallest number that can be allocated.  
[Setting range] 0, 2 to 6 

[Remarks] The location of placeable Time Slot changes according to 
Switching Point setting.  

 
Channel Code 

[Overview] Sets the Channelization Code.  
[Default] 1 
[Setting range] 1 to SF 
 
Slot Format 

[Function] Sets the slot format.  
[Default] 0 
[Setting range] 0 to 1 
[Remarks] The Slot Format is 0 (Fixed) when the HSPA RMC Type is 

RMC 0.5 Mbps.  
 

Data Type 

[Overview]  Sets the data type to be mapped to channel.  
[Default] PN9 
[Options] PN9, PN15, All0, All1, User File 
[Remarks] The default pattern values of PN9 and PN15 are same in 

a given channel, but they are different channel by 
channel.  

 
Redundancy Version Parameter 

[Overview] Sets the Redundancy Version.  
[Default] 0 
[Setting range] 0 to 7 
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Midamble K 

[Overview] Sets the Midamble K value.  
[Default] 16 
[Options] 2, 4, 6, 8, 10, 12, 14, 16 
 
UE spec shift 

[Overview] Sets the UE spec shift value.  
[Default] 16 
[Setting range] 1 to Midamble K 
[Remarks]  Available only when UE specification is selected for 

Midamble Config of Carrier Setting.  
 
N_IR 

[Overview] Sets the IR Buffer size. 
[Default] 7060 
[Setting range] 2788 to 84480 
 
UE ID 

[Overview] Sets the number of UE ID.  
[Default] 0 
[Setting range] 0 to 65535 
 
Number of HS-PDSCH per TS 

[Overview] Sets the number of HS-PDSCH per each time slot.  
[Default] 1 
[Setting range] 1 to SF 

 
Number of TS 

[Overview] Sets the number of time slots that HS-PDSCH uses.  
[Default] 3 
[Setting range] 1 to (6 – Switching Point) 

 
SF 

[Overview] Sets the spreading factor.  
[Default] 16 
[Options] 1, 16 
 
Modulation 

[Overview] This sets the modulation method of HS-DPCH.  
[Default] QPSK 
[Options] QPSK, 16QAM, 64QAM 
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Block Size 

[Overview] Displays the block size of information data.  
[Default] The following values will be automatically set according 

to the HSPA RMC Type.  
 HSPA RMC Type = RMC 48 kbps: 240 
 HSPA RMC Type = RMC 0.5 Mbps: 996 
 HSPA RMC Type = RMC 1.1 Mbps: 2893 
 HSPA RMC Type = RMC 1.6 Mbps: 1787 
HSPA RMC Type = RMC 2.2 Mbps: 2695 
 HSPA RMC Type = RMC 2.8 Mbps: 3105 

 

HS-SCCH 

When HS-SCCH tab is selected, the following items will be displayed.  

State 

[Overview] Turns On/Off the channel.  
[Default] OFF 
[Options] ON, OFF 
[Remarks] Parameter other than State cannot be set when State is 

OFF.  
 
Power 

[Overview]  Sets channel power.  
[Default] 0.00 dB 
[Setting range] –40.00 to 0.00 dB, Resolution 0.01 dB 
 
Time Slot 

[Overview] Sets the position of Time Slot to be allocated.  
[Default] 0 
[Setting range] 0, 2 to 6 
[Remarks] The location of placeable Time Slot changes according to 

Switching Point setting.  
 
Data Type 

[Overview]  Sets the data type to be mapped to channel.  
[Default] PN9 
[Options] PN9, PN15, All0, All1, User File 
[Remarks] The default pattern values of PN9 and PN15 are same in 

a given channel, but they are different channel by 
channel.  
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Channel Code 

[Overview] Sets the Channelization Code.  
[Default] 3 
[Setting range] 1 to 15 
 
Slot Format 

[Overview] Displays the slot format.  
[Default] 0, 5 
 
SF 

[Overview] Displays the spreading factor.  
[Default] 16 
 
TPC 

[Overview] Sets the TPC (Transmitter Power Control).  
[Default] All 0 
[Options] Repeat 101010, Repeat 010101, All 0, All 1, User File 
[Remarks] Available when the Slot Format is 5 to 9 or 15 to 24.  
 

SS 

[Overview] Sets the synchronization shift parameter.  
[Default] All 0 
[Options] Repeat 101010, Repeat 010101, All 0, All 1, User File 
[Remarks] Available when the Slot Format is 5 to 9 or 15 to 24.  
 
Midamble K 

[Overview] Sets the Midamble K value.  
[Default] 16 
[Options] 2, 4, 6, 8, 10, 12, 14, 16 
 
UE spec shift 

[Overview] Sets the UE spec shift value.  
[Default] 16 
[Setting range] 1 to Midamble K 
[Remarks] Available only when UE specification is selected for 

Midamble Config of Carrier Setting.  
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3.1.4.2 When Link is UL 

In the Common Setting dialog box, the following tabs are displayed when 
UL is set for Link.  

 UpPCH 

 PUSCH 

 DPCH 

 HS-SICH 

 E-PUCH 
What follows below is the breakdown of each setting item.  

Note: 

Note that some setting items cannot be configured in relation to 
other channels’ settings.  

UpPCH 

When UpPCH tab is selected, the following items will be displayed.  

State 

[Overview] Turns On/Off the channel.  
[Default] ON 
[Options] ON, OFF 
[Remarks]  Parameter other than State cannot be set when State is 

OFF.  
 
Power 

[Overview]  Sets channel power.  
[Default] 0.00 dB 
[Setting range] –40.00 to 0.00 dB, Resolution 0.01 dB 

 
Sync-UL code 

[Overview] Displays the SYNC code at Uplink.  
[Default] 0 

[Setting range] floor (Scrambling Code / 4) × 8  
to floor (Scrambling Code / 4) × 8 + 7 
 Where floor(x) is the function for finding the largest 
integer that does not exceed x.  
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PUSCH 

When PUSCH tab is selected, the following items will be displayed.  

State 

[Overview] Turns On/Off the channel.  
[Default] OFF 
[Options] ON, OFF 
[Remarks] Parameter other than State cannot be set when State is 

OFF.  
 
Power 

[Overview] Sets channel power.  
[Default] 0.00 dB 
[Setting range] –40.00 to 0.00 dB, Resolution 0.01 dB 
 
Time Slot 

[Overview] Sets the position of Time Slot to be allocated.  
[Default] 2 
[Setting range] 1 to 6 
[Remarks] The location of placeable Time Slot changes according to 

Switching Point setting.  
 
Data Type 

[Overview]  Sets the data type to be mapped to channel.  
[Default] PN9 
[Options] PN9, PN15, All0, All1, User File 
[Remarks] The default pattern values of PN9 and PN15 are same in 

a given channel, but they are different channel by 
channel.  

 
Channel Code 

[Overview] Sets the Channelization Code.  
[Default] 1 
[Setting range] 1 to SF 
 
Slot Format 

[Overview] Sets the slot format.  
[Default] 0 
[Setting range] 0 to 69 
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TFCI 

[Overview] Sets the TFCI (Transport Format Combination Indicator).  
[Default] 0 
[Setting range] 0 to 1023 
[Remarks] The setting range changes according to the Slot Format.  
 
TPC 

[Overview] Sets the TPC (Transmitter Power Control).  
[Default] All 0 
[Options] Repeat 101010, Repeat 010101, All 0, All 1, User File 
[Remarks] Available when the Slot Format is 5 to 9.  
 

SS 

[Overview] Sets the synchronization shift parameter.  
[Default] All 0 
[Options] Repeat 101010, Repeat 010101, All 0, All 1, User File 
[Remarks] Available when the Slot Format is 5 to 9.  
 
SF 

[Overview] Displays the spreading factor.  
[Default] 16 
 
Block Size 

[Overview] Sets the block size of information data.  
[Default] 246 
[Setting range] 1 to 5000 
 
CRC Size 

[Overview] Sets the CRC size (bit count) to add to Information Data.  
[Default] 16bits 
[Options] 8bits, 12bits, 16bits, 24bits 
 
Coding Type 

[Overview] Sets the channel coding type.  
[Default] Convolution-1/3 
[Options] Convolution-1/2, Convolution-1/3, Turbo-1/3 
 
Rate Matching Attribute 

[Overview] Displays the Rate Matching attribute.  
[Default] 246 
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Midamble K 

[Overview] Sets the Midamble K value.  
[Default] 16 
[Options] 2, 4, 6, 8, 10, 12, 14, 16 
 
UE spec shift 

[Overview] Sets the UE spec shift value.  
[Default] 16 
[Setting range] 1 to Midamble K 
[Remarks] Available only when UE specification is selected for 

Midamble Config of Carrier Setting.  
 

DPCH 

When DPCH tab is selected, the following items will be displayed.  

Number of RMC 

[Overview]  Sets the number of RMC.  
[Default] 1 
[Setting range] 1 to 8 
 
RMC 

[Overview]  Sets the RMC number, which edits detailed parameter.  
[Default] 1 
[Setting range] 1 to Number of RMC 
 
The following items are displayed for each RMC, and can be configured 
for each RMC.  

State 

[Overview] Turns On/Off the channel.  
[Default] ON 
[Options] ON, OFF 
[Remarks]  Parameter other than State of each RMC cannot be set 

when State is OFF.  
 
Power 

[Overview]  Sets channel power.  
[Default] 0.00 dB 
[Setting range] –40.00 to 0.00 dB, Resolution 0.01 dB 
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RMC Type 

[Overview]  Sets the RMC type.  
[Default] 12.2 kbps 
[Options] 12.2 kbps, 64 kbps, 144kbps, 384 kbps 
[Remarks] 144kps is available when the difference of Switching 

Point – (Time Slot –1) is 2 or more.  
384kps is available when the difference of Switching 
Point – (Time Slot –1) is 4 or more.  

 
Time Slot 

[Overview] Sets the position of Time Slot to be allocated.  
[Default] 1  
[Setting range] 1 to 6 

[Remarks] The location of placeable Time Slot changes according to 
Switching Point setting.  

 
Channel Code 

[Overview] Sets the Channelization Code.  
[Default] 1 
[Setting range] 1 to SF 
[Remarks] The value becomes 1 when RMC Type is 384 kbps.  
 
DTCH Data Type 

[Overview]  Sets the data type to be mapped to DTCH.  
[Default] PN9 
[Options] PN9, PN15, All0, All1, User File 
[Remarks] The default pattern values of PN9 and PN15 are same in 

a given channel, but they are different channel by 
channel.  

 
DTCH Rate Matching Attribute 

[Overview] Sets the Rate Matching attribute of DTCH.  
[Default] The following values will be automatically set according 

to the RMC type.  
 RMC Type = 12.2 kbps: 256 
 RMC Type = 64 kbps: 175 
 RMC Type = 144 kbps: 173 
 RMC Type = 384 kbps: 173 

[Setting range] 0 to 256 
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DCCH Data Type 

[Overview]  Sets the data type to be mapped to DCCH.  
[Default] PN9 
[Options] PN9, PN15, All0, All1, User File 
[Remarks] The default pattern values of PN9 and PN15 are same in 

a given channel, but they are different channel by 
channel.  

 
DCCH Rate Matching Attribute 

[Overview] Displays the Rate Matching attribute of DCCH.  
[Default] 256 
[Setting range] 0 to 256 
 
SF 

[Overview] Displays the spreading factor.  
[Default] The following values will be automatically set according 

to the RMC type.  
 RMC Type = 12.2 kbps: 8 
 RMC Type = 64 kbps: 2 
 RMC Type = 144 kbps: 2 
 RMC Type = 12.2 kbps: 2, 8 

 
TFCI 

[Overview] Sets the TFCI (Transport Format Combination Indicator).  
[Default] 0 
[Setting range] 0 to 31 
 
TPC 

[Overview] Sets the TPC (Transmitter Power Control).  
[Default] All 0 
[Options] Repeat 1010, Repeat 0101, All 0, All 1, User File 
[Remarks] A file name is displayed on-screen when User File is 

selected.  
 
SS 

[Overview] Sets the synchronization shift parameter.  
[Default] All 0 
[Options] Repeat 1010, Repeat 0101, All 0, All 1, User File 
[Remarks] A file name is displayed on-screen when User File is 

selected.  
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Midamble K 

[Overview] Sets the Midamble K value.  
[Default] 16 
[Options] 2, 4, 6, 8, 10, 12, 14, 16 
 
UE spec shift 

[Overview] Sets the UE spec shift value.  
[Default] 16 
[Setting range] 1 to Midamble K 
[Remarks]  Available only when UE specification is selected for 

Midamble Config of Carrier Setting.  
 
Block Size 

[Overview] Displays the block size of information data.  
[Default] The following values will be automatically set according 

to the RMC type.  
 RMC Type = 12.2 kbps: 244 
 RMC Type = 64 kbps: 1280 
 RMC Type = 144 kbps: 2880 
 RMC Type = 384 kbps: 3840 

 
Number of DPCH per TS 

[Overview] Sets the number of DPCH per each time slot.  
[Default] 1 
[Setting range] 1 to (SF – Channel Code + 1) 
 

HS-SICH 

When HS-SICH tab is selected, the following items will be displayed.  

State 

[Overview] Turns On/Off the channel.  
[Default] OFF 
[Options] ON, OFF 
[Remarks]  Parameter other than State cannot be set when State is 

OFF.  
 
Power 

[Overview] Sets channel power.  
[Default] 0.00 dB 
[Setting range] –40.00 to 0.00 dB, Resolution 0.01 dB 
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Time Slot 

[Overview] Sets the position of Time Slot to be allocated.  
[Default] 1 
[Setting range] 1 to 6 
[Remarks] The location of placeable Time Slot changes according to 

Switching Point setting.  
 
Data Type 

[Overview]  Sets the data type to be mapped to channel.  
[Default] PN9 
[Options] PN9, PN15, All0, All1, User File 
[Remarks] The default pattern values of PN9 and PN15 are same in 

a given channel, but they are different channel by 
channel.  

 
Channel Code 

[Overview] Sets the Channelization Code.  
[Default] 1 
[Setting range] 1 to 16 
 
Slot Format 

[Overview] Displays the slot format.  
[Default] 5 
 
TPC 

[Overview] Sets the TPC (Transmitter Power Control).  
[Default] All 0 
[Options] Repeat 101010, Repeat 010101, All 0, All 1, User File 
[Remarks] Available when the Slot Format is 5 to 9.  
 

SS 

[Overview] Sets the synchronization shift parameter.  
[Default] All 0 
[Options] Repeat 101010, Repeat 010101, All 0, All 1, User File 
[Remarks] Available when the Slot Format is 5 to 9.  
 
SF 

[Overview] Displays the spreading factor.  
[Default] 16 
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RTBS 

[Overview] Sets the recommended transport block size.  
[Default] 63 
[Setting range] 0 to 63 
 
RMF 

[Overview] Sets the recommended modulation format.  
[Default] QPSK 
[Options] QPSK, 16QAM, 64QAM 
 
ACK/NACK 

[Overview] Sets ACK/NACK.  
[Default] ACK 
[Options] ACK, NACK 
 
Midamble K 

[Overview] Sets the Midamble K value.  
[Default] 16 
[Options] 2, 4, 6, 8, 10, 12, 14, 16 
 
UE spec shift 

[Overview] Sets the UE spec shift value.  
[Default] 16 
[Setting range] 1 to Midamble K 
[Remarks] Available only when UE specification is selected for 

Midamble Config of Carrier Setting.  

E-PUCH 

When E-PUCH tab is selected, the following items will be displayed.  

HSPA RMC Type 

[Overview]  Sets the RMC type.  
[Default] FRC1 
[Options] FRC1, FRC2, FRC3, FRC4 
 

State 

[Overview] Turns On/Off the channel.  
[Default] OFF 
[Options] ON, OFF 
[Remarks]  Parameter other than State cannot be set when State is 

OFF.  
Power 

[Overview]  Sets channel power.  
[Default] 0.00 dB 
[Setting range] –40.00 to 0.00 dB, Resolution 0.01 dB 



 

Chapter 3  Detailed Description of Functions 

3-40 

 
Time Slot 

[Overview] Sets the position of Time Slot to be allocated.  
[Default] 1 
[Setting range] 1 to 6 
[Remarks] The location of placeable Time Slot changes according to 

Switching Point setting.  
 
Data Type 

[Overview]  Sets the data type to be mapped to channel.  
[Default] PN9 
[Options] PN9, PN15, All0, All1, User File 
[Remarks] The default pattern values of PN9 and PN15 are same in 

a given channel, but they are different channel by 
channel.  

 
Channel Code 

[Overview] Sets the Channelization Code.  
[Default] 1 
[Setting range] 1 to SF 
 
SF 

[Overview] Displays the spreading factor.  
[Default] The following values will be automatically set according 

to the HSPA RMC Type.  
 HSPA RMC Type = FRC1: 4 
 HSPA RMC Type = FRC2: 2 
 HSPA RMC Type = FRC3: 2 
 HSPA RMC Type = FRC4: 1 

 
Modulation 

[Overview] Sets the Modulation.  
[Default] QPSK 

The following values will be automatically set according 
to the HSPA RMC Type when the Channel Coding is On.  
 HSPA RMC Type = FRC1: QPSK 
 HSPA RMC Type = FRC2: QPSK 
 HSPA RMC Type = FRC3: 16QAM 
 HSPA RMC Type = FRC4: 16QAM 

[Setting range] QPSK, 16QAM 
[Remarks] Display only when Channel Coding is On.  
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Block Size 

[Overview] Displays the block size of information data.  
[Default] The following values will be automatically set according 

to the HSPA RMC Type.  
 HSPA RMC Type = FRC1: 282 
 HSPA RMC Type = FRC2: 1139 
 HSPA RMC Type = FRC3: 2445 
 HSPA RMC Type = FRC4: 6406 

 
Number of E-DCH codes per TS 

[Overview] Displays the number of E-DCH codes per Time Slot.  
[Default] 1 
 
Number of TS 

[Overview] Displays the number of E-DCH Time Slot.  
[Default] The following values will be automatically set according 

to the HSPA RMC Type.  
 HSPA RMC Type = FRC1: 1 
 HSPA RMC Type = FRC2: 2 
 HSPA RMC Type = FRC3: 3 
 HSPA RMC Type = FRC4: 4 

 
Midamble K 

[Overview] Sets the Midamble K value.  
[Default] 16 
[Options] 2, 4, 6, 8, 10, 12, 14, 16 
 
UE spec shift 

[Overview] Sets the UE spec shift value.  
[Default] 16 
[Setting range] 1 to Midamble K 
[Remarks] Available only when UE specification is selected for 

Midamble Config of Carrier Setting.  
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3.1.5 Pattern Setting  
Pattern Setting is used to make settings regarding waveform files.  

Package  

[Overview] Sets the package.  
[Default] TD-SCDMA (when running on MG3710A) 
 
Export File Name 

[Overview] Sets the pattern name.  
[Default] TestPattern (when running on MG3710A) 
 
Comment 

[Overview] Displays the Comment setting screen to make settings.  
 
Calculation & Load button 

[Overview] Displays Calculation & Load when running on MG3710A. 
Generates waveform and loads the waveform patterns to 
memory.  

 When not running on MG3710A, Calculation will display 
and only the generation of waveform pattern is 
performed.  

 
Calculation & Play button 

[Overview] Displays Calculation & Play when running on MG3710A.  
 Generates waveform and loads the waveform patterns to 

memory. You can then select the waveform pattern to 
output (playback).  

 When not running on MG3710A, Exit will display and 
exits this application.  
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3.1.6 Sub-frame Structure screen 
The Sub-frame Structure screen opens when Show Sub-frame Structure 
is selected at the Edit menu of the Main screen or when  on the 
Tool bar is clicked.  

The Sub-frame Structure screen provides mapping indication of each 
channel in which RUs (Resource Units) allocated in each channel are 
color-coded. The screen shows mapping for 7 Slots (1 Sub-frame).  

Note that this screen is only for display, and thus cannot be edited.  

Each channel is allocated in a cell comprising RUs (Resource Units). The 
horizontal axis consists of 7 RUs in the Time Slot direction, while the 
vertical axis consists of 16 RUs in the Channel Code direction.  
The allocatable Time Slots are:  
Time Slot#1 to Time Slot#SP (SP: Switching Point) when Link is UL, 
and 
Time Slot#0 and Time Slot#SP+1 to Time Slot#6 when Link is DL.  
When Channel State is On,  
the initial value is the RU with the smallest number Time Slot and the 
smallest number Channel Code among allocatable RUs. Move to the RU 
which has been already occupied by another channel is not available.  

For the details about how many RUs, Time Slots, and Chanel Codes a 
single channel occupies, refer to Table 3.1.6-1.  
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Switching Point=n (n=1, 2, 3, 4, 5, 6) means an interval between Time 
Slot#n and Time Slot#(n+1). The position of Switching Point is indicated 
as ▲.  

 

Resource Unit

Channel
Code#16

Channel
Code#1 

 

Figure 3.1.6-1  Sub-frame Structure Screen (Link=DL) 
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Downlink 

The RU (Resource Unit) of each channel to be displayed when Link is 
DL: P-CCPCH, S-CCPCH, PICH, DPCH, HS-PDSCH. DwPCH is not 
displayed.  

Uplink 

The RU (Resource Unit) of each channel to be displayed when Link is 
UL: DPCH. UpPCH is not displayed.  

Table 3.1.6-1 The numbers of RUs, Time Slots, and Channel Codes occupied by a single 

channel 

Channel or RMC Type 
No. of Time 

Slot 

No. of 
Channel 

Code 
No. of RU 

C-CCPCH 1 2 2 
S-CCPCH 1 2 2 
PICH 1 2 2 

DPCH (Link = DL) 1 Number of 
DPCH per TS 

Number 
of DPCH 
per TS 

HS-PDSCH Number of 
TS 

Number of 
HS-PDSCH 

per TS 

(Number 
of TS) × 
(Number 

of 
HS-PDSC
H per TS) 

RMC UL 12.2 kbps 1 2 2 
RMC UL 64 kbps 1 8 8 
RMC UL 144 kbps 2 8 16 
RMC UL 384 kbps 4 10 40 
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3.1.7 Export File screen 
When Calculation is selected from the Edit menu or the   tool 
button is clicked on the main screen, the Export File screen is displayed.  
The Export File screen is displayed when generating a waveform pattern.  
In this screen, the output destination folder, package name, file name, 
and comment for the waveform pattern to be generated can be specified.  

Output destination 
folder selection 
button 

Package name 

Waveform 
pattern name 

Comment 

 

Figure 3.1.7-1  Export File Screen 

 

 Export destination folder 

Click the output destination folder selection button to select an export 
destination folder.  

 

Figure 3.1.7-2  Browse for Folder Screen 
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The default destination folder for waveform patterns in each 
instrument is shown in the table below.  

Table 3.1.7-1 Default export destination folder 

Instrument 
Operating 

Environment 
Export destination folder 

MG3700A -- 
X:\IQproducer\TD-SCDMA\Data 
(X:\IQproducer is a folder where IQproducer is installed) 
This can be changed.  

MG3710A 
MG3710 

C:\Anritsu\MG3710A\User Data 
\Waveform\”Package name” 
This cannot be changed. 

PC Same as MG3700A. 

MS269xA, 
MS2830A 

MS269x, 
MS2830 

When installed OS is Windows Embedded Standard 7. 
C:\Anitsu\Signal Analyzer\System\Waveform 
Other than above 
C:\Program Files\Anritsu Corporation 
\Signal Analyzer\System\Waveform\” Package name” 
This cannot be changed. 

PC Same as MG3700A. 

 Package name 

Following characters can be input for Package.  
No. of characters Up to 31 characters 
Available characters English alphanumeric characters and the 

following symbols 
! % & ( ) + = ‘ { } _ - ^ @ [ ] 

Default TD-SCDMA (when running on MG3710A) 

 Waveform pattern name (Export File Name) 

Following characters can be input for Export File Name.  
No. of characters Up to 20 characters 
Available characters English alphanumeric characters and the 

following symbols 
! % & ( ) + = ‘ { } _ - ^ @ [ ] 

Default TestPattern (when running on MG3710A) 

 Comment 

Following characters can be input for Comment.  
No. of characters Up to 38 characters × 3 lines 
Available characters English alphanumeric characters 

When the waveform pattern package name, file name, and comment are 
set, click OK on the Export File screen. The Calculation screen shown in 
Figure 3.1.8-1 is displayed and waveform pattern generation starts 
(package name, file name must be set to start waveform pattern 
generation).  
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3.1.8 Calculation screen 
Clicking Calculation & Load, Calculation & Play, or the OK button on 
the Export File screen will start the waveform generation.  

The Calculation screen is displayed while a waveform pattern is being 
generated. On this screen, the progress bar is displayed indicating the 
generation process of the waveform pattern and the progress of the 
waveform pattern generation. The generation of the waveform pattern 
can be stopped by clicking Cancel. When cancelled, it returns to the main 
screen.  

 

Progress report

Progress bar

Cancel button
 

Figure 3.1.8-1  Calculation Screen (In Progress) 

 

After waveform pattern generation is finished, the message “Calculation 
Completed.” is displayed in the progress window and the Cancel button 
changes to the OK button.  

When the generation is complete, you can return to the setting screen by 
clicking the OK button. After waveform generation, two files with .wvi 
and .wvd extension are output.   

 

 

Figure 3.1.8-2  Calculation Screen (Completed) 

 

Note: 

When using this software on MG3710A, and selecting Calculation 
& Load or Calculation & Play, the waveform generation ends 
without displaying the above screen.  
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3.1.9 Calculation & Load 
Note: 

This function is available only when this software is used on 
MG3710A.  

When Calculation & Load is selected, the Load Setting screen will 
display after waveform generation.  

Button for selecting load destination 

 

 

Figure 3.1.9-1  Load Setting Screen 

 

The Select Memory screen will display after clicking the load destination 
in the Load Setting screen.  

 

Figure 3.1.9-2  Select Memory Screen 

After selecting the load destination of generated waveform in the Select 
Memory screen and clicking the OK button, the Load Setting screen will 
be shown again. Click the OK button in the Load Setting screen, and 
then the loading of waveform starts.  

Note: 

To exit this screen without loading the waveform pattern, click the 
Cancel button in the Load Setting screen.  
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3.1.10 Calculation & Play 
Note: 

This function is available only when this software is used on 
MG3710A.  

When Calculation & Play is selected, after waveform creation is 
completed, the created waveform is loaded into memory, selected and 
output.  

When the 2nd Vector Signal Generator (option) is installed, the Select SG 
screen is displayed before the start of waveform generation. This screen 
is used to select the signal generator for outputting the created waveform 
pattern.  

 

Figure 3.1.10-1  Select SG Screen 

 

3.1.11 Resetting all parameters 
Open the following file to reset all parameters.  

X:\IQproducer\TD-SCDMA\TD-SCDMA_InitialParameter.xml 
(“X:\IQproducer” indicates the folder where the IQproducerTM is 
installed.) 
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3.2 Waveform Pattern Generation Procedure 
3.2.1 Downlink 

This section shows a procedure for creating a waveform pattern, using an 
TD-SCDMA downlink waveform pattern as an example.  

1. Start the software.  

2. Set the Common Setting parameters as shown in Table 3.2.1-1. The 
parameters that are not shown below are used with their default 
values, or are automatically set according to other parameter 
settings.  

Table 3.2.1-1  Common Setting 

Common Setting 

Number of Sub-frames 1 
Link DL 

Number of Carriers 1 
 
3. Set the parameters in Carrier#1 tab as shown in Table 3.2.1-2.  

Table 3.2.1-2  Carrier#1 Setting 

Carrier#1 

Frequency Offset 0 MHz 
Relative Power 0.00 dB 
Channel Coding OFF 
Switching Point 3 
Scrambling Code 0 
Midamble Config Default 

 
4. Click Channel Setting, and set the State of each channel displayed 

in Channel Setting as in Table 3.2.1-3.  
Table 3.2.1-3  State of Each Channel  

Channel Setting 

P-CCPCH ON 
S-CCPCH OFF 
DwPCH ON 
PDSCH OFF 
PICH OFF 
DPCH ON 

HS-PDSCH OFF 
HS-SCCH OFF 
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5. Click the P-CCPCH tab, and set the parameters as in Table 3.2.1-4.  

Table 3.2.1-4  P-CCPCH Setting 

P-CCPCH 

State ON 
Power 0.00 dB 

Data Type PN9 
UE spec shift Disabled 

SF 16 (display only) 

 
6. Click the DwPCH tab, and set the parameters as in Table 3.2.1-5.  

Table 3.2.1-5  DwPCH Setting 

DwPCH 

State ON 
Power 0.00 dB 

Sync-DL code 0 

 
7. Click the DPCH tab, and set the parameters as in Table 3.2.1-6.  

Table 3.2.1-6  DPCH Setting 

DPCH 

Number of RMC 3 
RMC = 1 

State ON 
Power 0.00 

RMC Type --- 
Time Slot 4 

Channel Code 1 
DTCH Data Type PN9 

DTCH Rate Matching Attribute --- 
DCCH Data Type --- 

DCCH Rate Matching Attribute --- 
SF 16 

TFCI --- 
TPC --- 
SS --- 

Midamble K 16 
UE spec shift --- 

Number of DPCH per TS 8 
Block Size --- 
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Table 3.2.1-6  DPCH Setting (Continued) 

RMC = 2 
State ON 
Power 0.00 

RMC Type --- 
Time Slot 5 

Channel Code 1 
DTCH Data Type PN9 

DTCH Rate Matching Attribute --- 
DCCH Data Type --- 

DCCH Rate Matching Attribute --- 
SF 16 

TFCI --- 
TPC --- 
SS --- 

Midamble K 16 
UE spec shift --- 

Number of DPCH per TS 8 
Block Size --- 

RMC = 3 
State ON 
Power 0.00 

RMC Type --- 
Time Slot 6 

Channel Code 1 
DTCH Data Type PN9 

DTCH Rate Matching Attribute --- 
DCCH Data Type --- 

DCCH Rate Matching Attribute --- 
SF 16 

TFCI --- 
TPC --- 
SS --- 

Midamble K 16 
UE spec shift --- 

Number of DPCH per TS 8 
Block Size --- 
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8. Click the Calculation button to display the Export File screen. Enter 
TD_SCDMA and Downlink_8DPCH for the Package name and File 
name, respectively. Then click OK.  

9. The Calculation screen is displayed and waveform pattern 
generation starts. After the calculation is completed, click OK to 
finish the waveform generation.  

10. The following files are output in the folder specified in 3.1.7 “Export 
File screen”: 
Downlink_8DPCH.wvi, Downlink_8DPCH.wvd 
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3.2.2 Uplink 
This section shows a procedure for creating a waveform pattern, using an 
TD-SCDMA uplink waveform pattern as an example.  

Procedure for generating Uplink waveform 

1. Start the software.  

2. Set the Common Setting parameters as shown in Table 3.2.2-1. The 
parameters that are not shown below are used with their default 
values, or are automatically set according to other parameter 
settings.  

Table 3.2.2-1  Common Setting 

Common Setting 

Number of Sub-frames 1 
Link UL 

Number of Carriers 1 

 

3. Set the parameters in Carrier#1 tab as shown in Table 3.2.1-2.  

Table 3.2.2-2  Carrier#1 Setting 

Carrier#1 

Frequency Offset 0 MHz 
Relative Power 0.00 dB 
Channel Coding ON 
Switching Point 3 
Scrambling Code 0 
Midamble Config Default 

 

4. Click Channel Setting, and set the State of each channel displayed 
in Channel Setting as in Table 3.2.2-3.  

Table 3.2.2-3  State of Each Channel  

Channel Setting 

UpPCH ON 
PUSCH OFF 
DPCH ON 

HS-SICH OFF 
E-PUCH OFF 
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5. Click the UpPCH tab, and set the parameters as in Table 3.2.2-4. 

Table 3.2.2-4  UpPCH Setting  

UpPCH 

State ON 
Power 0.00 

Sync-UL code 0 

 

6. Click the DPCH tab, and set the parameters as in Table 3.2.2-5.  

Table 3.2.2-5  DPCH Setting 

DPCH 

Number of RMC 1 
RMC = 1 

State ON 
Power 0.00 

RMC Type 12.2 kbps 
Time Slot 1 

Channel Code 1 
DTCH Data Type PN9 

DTCH Rate Matching Attribute 256 
DCCH Data Type PN9 

DCCH Rate Matching Attribute 256 
SF 8 

TFCI 0 
TPC All 0 
SS All 0 

Midamble K 16 
UE spec shift --- 

Block Size 244 

 

7. Click the Calculation button to display the Export File screen. Enter 
TD_SCDMA and UL_RMC_12_2kbps for the Package name and 
Export File Name, respectively. Then click OK. 

8. The Calculation screen is displayed and waveform pattern 
generation starts. After the calculation is completed, click OK to 
finish the waveform generation.  

9. The following files are output in the folder specified in 3.1.7 “Export 
File screen”: UL_RMC_12_2kbps.wvi
 UL_RMC_12_2kbps.wvd 
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3.3 Saving/reading parameters 
The numeric values and settings for each item can be saved in a 
parameter file by using the software.  

3.3.1 Saving parameter file 
When running on PC, MS2690A/MS2691A/MS2692A, or MS2830A 

(1) Click Save Parameter File button in File menu or click  button 
to display the parameter file saving screen.  

 

Figure 3.3.1-1  Parameter File Saving Screen 

 

(2) Assign the Input Folder, enter a desired name into the File Name 
box and then click Save button to save the parameter.  

When running on MG3710A  

(1) Click the Save Parameter File button in File menu or click the   
button to display the parameter file saving screen.  

 

Figure 3.3.1-2  Parameter File Saving Screen (MG3710A) 

 

(2) Select the folder to store the file in the Directories field, and then 
enter the name of the file using the File Name box. Click OK to save 
the parameter file. To initialize the setting in the Directories field, 
click the Default Root button. 
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3.3.2 Reading parameter file 
When running on PC, MS2690A/MS2691A/MS2692A, or MS2830A 

(1) Select Recall Parameter File from the File menu or click the  
tool button to display the parameter file reading screen.  

 

Figure 3.3.2-1  Parameter File Reading Screen 

 

(2) Select a parameter file to be read from the file list, and then click 
the Open button to read the selected parameter file.  

When running on MG3710A 

(1) Select Recall Parameter File from the File menu or click the  
tool button to display the parameter file reading screen.  

 

Figure 3.3.2-2  Parameter File Reading Screen (MG3710A) 

 

 (2) Select the directory where the files to be loaded is stored in the 
Directories field. Click the desired file from the File List, and click 
OK. To initialize the setting in the Directories field, click the Default 
Root button. 
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3.4 User File Reading Screen 
When running on PC, MS2690A/MS2691A/MS2692A, or MS2830A  

(1) When User File is selected for Data Type setting in the Channel 
Setting screen, the user file reading screen is displayed.  

 

Figure 3.4-1  User File Reading Screen  

 

(2) Select a user file to be read from the file list, and then click Open to 
read the selected user file.  

If an unsupported User File is selected, an error is displayed. Refer to 
Appendix B “User File Format” for details on the user file format. 

When running on MG3710A 

(1) When User File is selected for Data Type setting in the Channel 
Setting screen, the user file reading screen is displayed.  

 

Figure 3.4-2   User File Reading Screen (MG3710A) 
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(2) Select the directory where the user files to be loaded is stored in the 
Directories field. Click the desired file from the File List, and click 
OK. To initialize the setting in the Directories field, click the Default 
Root button.  

If an unsupported User File is selected, an error is displayed. Refer to 
Appendix B “User File Format” for details on the user file format. 
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3.5 Displaying Graph  
The generated waveform pattern can be displayed in a CCDF, FFT, and 
Time Domain graph by using this software. For details of graph display, 
refer to each one of the following:  

 MG3700A/MG3710A Vector Signal Generator MG3740A Analog 
Signal Generator Operation Manual (IQproducer™) 
4.3 “CCDF Graph Display”, 4.4 “FFT Graph Display”, 4.13 “Time 
Domain Graph Display” 

 MS2690A/MS2691A/MS2692A or MS2830A Vector Signal Generator 
Operation Manual (IQproducer™) 
4.3 “CCDF Graph Display”, 4.4 “FFT Graph Display”, 4.9 “Time 
Domain Graph Display” 

 

Displaying CCDF graph 

(1) Generate a waveform pattern menu by executing “Calculation”.  

(2) Select CCDF from the Simulation menu or click the  tool 
button. The CCDF Graph Monitor screen shown is displayed with 
the trace of the generated waveform pattern.  

 

Figure 3.5-1  CCDF Graph Monitor Screen 

 

 When a waveform pattern is generated by changing parameters and 
executing “Calculation” while other traces are displayed in the 
CCDF Graph Monitor screen, the trace of the waveform pattern 
newly generated can be displayed in either of the following two 
methods:  
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 Displaying the new trace in the same screen as the previous 
traces 

 Deleting the previous traces to display the new trace 
 

 Note: 

The CCDF, FFT, and Time Domain graphs cannot be 

generated at the same time. When displaying one graph while 

another graph is being displayed, execute the graph generation 

of the former after that of the latter is completed. 

 

■ Displaying the new trace in the same screen as the previous traces 

(1) Set Add for Quick Add Mode on the lower-left of the CCDF Graph 
Monitor screen.  

(2) Select CCDF from the Simulation menu or click the  tool 
button. The CCDF Graph Monitor screen shown is displayed 
with the trace of the generated waveform pattern.  
Up to eight traces can be displayed by repeating this procedure.  

 
■ When deleting the previous traces to display a new trace: 

(1) Set Clear for Quick Add Mode on the lower-left of the CCDF 
Graph Monitor screen.  

(2) Select CCDF from the Simulation menu or click the  tool 
button. The confirmation message shown in Figure 3.5-2 below 
appears:  

 

Figure 3.5-2  Confirmation Message 

 

 Click Yes. The previous traces are deleted, and the trace of the 
waveform pattern newly generated is displayed.  

Displaying FFT graph 

(1) Generate a waveform pattern menu by executing “Calculation”.  

(2) Select FFT from the Simulation menu or click the  tool 
button. The FFT Graph Monitor screen shown is displayed with 
the trace of the generated waveform pattern.  
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Figure 3.5-3  FFT Graph Monitor Screen 

 

When a waveform pattern is generated by changing parameters and 
executing “Calculation” while other traces are displayed in the FFT 
Graph Monitor screen, the trace of the waveform pattern newly 
generated can be displayed in either of the following two methods:  

 Displaying the new trace in the same screen as the previous 
traces 

 Deleting the previous traces to display the new trace 
 

 Note: 

The CCDF, FFT, and Time Domain graphs cannot be 
generated at the same time. When displaying one graph while 
another graph is being displayed, execute the graph generation 
of the former after that of the latter is completed. 

 

 
■ Displaying the new trace in the same screen as the previous traces 

(1) Set Add for Quick Add Mode on the lower-left of the FFT Graph 
Monitor screen.  

(2) Select FFT from the Simulation menu or click the  tool 
button. The FFT Graph Monitor screen shown is displayed with 
the trace of the generated waveform pattern.  
Up to four traces can be displayed by repeating this procedure.  

■ When deleting the previous traces to display a new trace: 

(1) Set Clear for Quick Add Mode on the lower-left of the FFT Graph 
Monitor screen.  
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(2) Select FFT from the Simulation menu or click the  tool 
button. The confirmation message shown in Figure 3.5-4 below 
appears: 

 

Figure 3.5-4  Confirmation Message 

 

 Click Yes. The previous traces are deleted, and the trace of the 
waveform pattern newly generated is displayed.  

 

Displaying the Time Domain graph 

(1) Generate a waveform pattern menu by executing “Calculation”.  

(2) When Time Domain is clicked in the Simulation menu or  is 
clicked, the Time Domain graph screen shown in Figure 3.5-5 is 
displayed, along with a trace of the generated waveform pattern.  

 

 

Figure 3.5-5  Time Domain Screen 

 

 When a waveform pattern is generated by changing parameters and 
executing “Calculation” while other traces are displayed in the Time 
Domain screen, the trace of the waveform pattern newly generated 
can be displayed in either of the following two methods:  
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 Displaying the new trace in the same screen as the previous 
traces 

 Deleting the previous traces to display the new trace 
 

 Note: 

The CCDF, FFT, and Time Domain graphs cannot be 
generated at the same time. When displaying one graph while 
another graph is being displayed, execute the graph generation 
of the former after that of the latter is completed. 

 

 
■ Displaying the new trace in the same screen as the previous traces 

(1) Set Add for Quick Add Mode on the lower-left of the Time 
Domain screen.  

(2) When Time Domain is clicked in the Simulation menu or  
is clicked, a trace of the newly generated waveform pattern is 
added to the Time Domain graph screen.  
Up to four traces can be displayed by repeating this procedure.  

■ When deleting the previous traces to display a new trace: 

(1) Set Clear for Quick Add Mode on the lower-left of the Time 
Domain screen.  

(2) Select Time Domain from the Simulation menu or click the  
tool button. The confirmation message shown in Figure 3.5-6 
below appears: 

 

Figure 3.5-6  Confirmation Message 

 

 Click Yes. The previous traces are deleted, and the trace of the 
waveform pattern newly generated is displayed.  
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3.6 Clipping  
This function performs clipping processing for a waveform pattern 
generated by each signal generation application.  

(1) Click Clipping from the Edit menu or click the  tool button. 
The Clipping setting screen s appears.  

 

 

Figure 3.6-1  Clipping Setting Screen 

 

(2)  Click  to select the wvi file of the waveform pattern to 
be used. The full path of the selected wvi file is displayed in the 
Input File text box.  

(3) Set values in the Threshold Level, Repetition, Filter Type, Roll 
Off/BT, and Bandwidth text boxes.  

(4) Select Calculation from the Edit menu or click the   button to 
complete setting.  

(5) Make settings on the Export File screen and click the OK button to 
generate a waveform pattern.  

(6) Display the generated waveform pattern in graph. Refer to 3.5 
“Graph display”.  

For details on clipping, refer to each one of the following:  

 MG3700A/MG3710A Vector Signal Generator MG3740A Analog 
Signal Generator Operation Manual (IQproducer™) 
4.14 “Clipping” 

 MS2690A/MS2691A/MS2692A or MS2830A Vector Signal Generator 
Operation Manual (IQproducer™) 
4.10 “Clipping” 

 

 



 

3.7 Other functions 

3-67 

3 

D
etailed D

escription
 of F

u
n

ction
s 

3.7 Other functions 
3.7.1 Auxiliary signal output 

Select a waveform pattern generated by the TD-SCDMA IQproducer™ on 
this equipment to output the marker that is synchronized with the RF 
signal as an auxiliary signal from the AUX on the rear panel of this 
equipment.  

Markers described below are automatically set for the waveform patterns 
when they are generated. By using the Marker Edit function which is a 
peripheral function of the Time Domain graph, a waveform pattern can 
be generated with these markers edited.  

For details of Marker Edit function, refer to each one of the following: 

 MG3700A/MG3710A Vector Signal Generator MG3740A Analog 
Signal Generator Operation Manual (IQproducer™) 
4.13.12 “Marker edit function” 

 MS2690A/MS2691A/MS2692A or MS2830A Vector Signal Generator 
Operation Manual (IQproducer™) 
4.9.12 “Marker edit function” 

 
As an auxiliary signal, the following pulses are output.  

 Pulse synchronized with the beginning of Sub-frame  

This pulse is output as Marker1 signal.  

 Pulse synchronized in the time period during which Time Slot or 
SYNC UL/DL code is ON  

This pulse is output as Marker 2 signal.  

For the error range of the auxiliary signals against the RF output, refer 
to each one of the following: 

 MG3700A/MG3710A Vector Signal Generator MG3740A Analog 
Signal Generator Operation Manual (IQproducer™) 
4.5.6 “Input file format” 

 MS2690A/MS2691A/MS2692A or MS2830A Vector Signal Generator 
Operation Manual (IQproducer™) 
4.5.6 “Input file format” 
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The following operations are required to output a modulated signal from 
this equipment using the waveform pattern generated by this software: 

• Transferring waveform pattern to internal hard disk 
• Loading waveform patterns from the hard disk to the waveform 

memory 
• Selecting a waveform pattern to be output from this equipment 
 
This chapter explains the details of these operations. 

 

4.1 For MG3700A or MG3710A ....................................... 4-2 
4.1.1 Transferring waveform pattern to internal  

hard disk ........................................................ 4-2 
4.1.2 Loading to Waveform Memory ...................... 4-4 
4.1.3 Selecting Waveform Pattern .......................... 4-5 

4.2 For MS2690A/MS2691A/MS2692A or MS2830A ...... 4-6 
4.2.1 Transferring waveform pattern to internal 

hard disk ........................................................ 4-6 
4.2.2 Loading to Waveform Memory ...................... 4-6 
4.2.3 Selecting Waveform Pattern .......................... 4-7 
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4.1 For MG3700A or MG3710A 
This section describes how to download a waveform pattern created for 
the MG3700A/MG3710A to the hard disk of the MG3700A/MG3710A and 
output the pattern.  

4.1.1 Transferring waveform pattern to internal hard disk 
The waveform pattern created with this software can be transferred to 
the internal hard disk in the following ways:  

Note: 
This operation is not necessary if you are using MG3710A and 
have generated waveform patterns on MG3710A.  

For MG3700A 
• LAN 
• CompactFlash Card 
 
For MG3710A 
• LAN 
• External device such as USB Memory 
 
■Transferring from PC via LAN (MG3700A，MG3710A) 
Two IQproducerTM tools can be used to transfer a waveform pattern to 
the MG3700A/MG3710A via a LAN.  

• Transfer & Setting Wizard 
Start this wizard by clicking the Transfer & Setting Wizard button of 
this software or by selecting Simulation & Utility tab → Transfer & 
Setting Wizard from the IQproducerTM after creating a waveform 
pattern. For details, refer to Section 4.7 “File Transfer and Loading to 
Memory Using Transfer & Setting Wizard” in the 
MG3700A/MG3710A Vector Signal Generator MG3740A Analog 
Signal Generator Operation Manual (IQproducer™).  
Transferring a waveform pattern to the internal hard disk of the 
MG3700A/MG3710A, loading the waveform from the hard disk to the 
waveform memory, and then outputting the waveform pattern can be 
done using this wizard.  
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• Transfer & Setting Panel 
This function is loaded by selecting Transfer & Setting Panel in the 
Simulation & Utility tab of the IQproducer™. For details, refer to 
Section 5.2 “Transferring Waveform Pattern” in the 
MG3700A/MG3710A Vector Signal Generator MG3740A Analog 
Signal Generator Operation Manual (IQproducer™).  
Specify the folder that contains the waveform pattern to transfer to 
the MG3700A/MG3710A in the PC-side tree of Transfer & Setting 
Panel. 
 

■Transferring using a CF card (MG3700A) 
Copy the waveform pattern (***.wvi and ***.wvd files) to be downloaded 
to the MG3700A to the root directory of a CF card.  

Insert the CF card into the card slot on the front panel of the MG3700A, 
and then copy the file to the hard disk. For details about how to use a CF 
card to transfer a waveform pattern, refer to (1) Loading waveform file in 
memory in Section 3.5.2 of the MG3700A Vector Signal Generator 
Operation Manual (Mainframe). 

■Transferring via external device such as USB memory (MG3710A) 
For details about how to transfer a waveform pattern created using this 
software to the hard disk of the MG3710A, refer to Section 7.3.6 “Copying 
external waveform pattern: Copy” in the MG3710A Vector Signal 
Generator MG3740A Analog Signal Generator Operation Manual 
(Mainframe).  
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4.1.2 Loading to Waveform Memory 
To output a modulated signal using a waveform pattern, it is necessary to 
load the waveform pattern that was transferred to the internal hard disk 
of the MG3700A/MG3710A (described in Section 4.1.1 “Transferring 
waveform pattern to internal hard disk”) to the waveform memory. A 
waveform pattern can be loaded into the waveform memory in the 
following two ways.  

■Configuring using the mainframe  
A waveform pattern can be loaded into the waveform memory by using 
the instruction panel of the MG3700A/MG3710A or by using a remote 
command.  

For operation using the front panel, refer below: 

• Section 3.5.2 (1) “Loading waveform file in memory” in the MG3700A 
Vector Signal Generator Operation Manual (Mainframe) 

• Section 7.3.4 “Loading waveform pattern: Load” in the MG3710A 
Vector Signal Generator MG3740A Analog Signal Generator 
Operation Manual (Mainframe) 

 
For operation using remote commands, refer below: 

• Chapter 4 “Remote Control” in the MG3700A Vector Signal 
Generator Operation Manual (Mainframe) 

• Section 7.3.4 “Loading waveform pattern: Load” in the MG3710A 
Vector Signal Generator MG3740A Analog Signal Generator 
Operation Manual (Mainframe) 

 
■Using Transfer & Setting Panel of IQproducerTM 
A waveform pattern can be loaded from the LAN-connected PC to the 
memory by using Transfer & Setting Panel, which can be opened from 
the Simulation & Utility tab. For details, refer to Section 4.6 “File 
Transfer and Loading to Memory Using Transfer & Setting Panel” in the 
MG3700A/MG3710A Vector Signal Generator MG3740A Analog Signal 
Generator Operation Manual (IQproducer™). 

 



 

4.1 For MG3700A or MG3710A 

4-5 

4 

H
ow

 to U
se W

aveform
 Patterns 

4.1.3 Selecting Waveform Pattern 
Select a waveform pattern to use for modulation from the waveform 
patterns loaded into the waveform memory of the MG3700A/MG3710A 
according to Section 4.1.2 “Loading to waveform memory”. A waveform 
pattern can be selected in the following two ways. 

■Configuring using the MG3700A/MG3710A 
Waveform patterns to be used for modulation can be selected by 
operating the equipment panel or by using a remote command.  

For operation using the front panel, refer below:  

• Section 3.5.2 (4) “Outputting pattern loaded in Memory A for 
modulation in Edit mode” in the MG3700A Vector Signal Generator 
Operation Manual (Mainframe) 

• Section 7.3.5 “Selecting output waveform pattern: Select” in the 
MG3710A Vector Signal Generator MG3740A Analog Signal 
Generator Operation Manual (Mainframe) 

 
For operation using remote commands, refer below: 

• Chapter 4 “Remote Control” in the MG3700A Vector Signal Generator 
Operation Manual (Mainframe) 

• Section 7.3.5 “Selecting output waveform pattern: Select” in the 
MG3710A Vector Signal Generator MG3740A Analog Signal 
Generator Operation Manual (Mainframe) 

 

■Using Transfer & Setting Panel of IQproducerTM 
A waveform pattern can be loaded from the LAN-connected PC to the 
memory, and also selected for modulation. This is done by using Transfer 
& Setting Panel, which can be opened from the Simulation & Utility tab. 
For details, refer to Section 4.6 “File Transfer and Loading to Memory 
Using Transfer & Setting Panel” in the MG3700A/MG3710A Vector 
Signal Generator MG3740A Analog Signal Generator Operation Manual 
(IQproducer™). 
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4.2 For MS2690A/MS2691A/MS2692A or MS2830A 
This section describes how to download a waveform pattern created for 
the MS2690A/MS2691A/MS2692A or MS2830A to the hard disk of the 
MS2690A/MS2691A/MS2692A or MS2830A and output the pattern.  

 

4.2.1 Transferring waveform pattern to internal hard disk 
For details about how to transfer a waveform pattern created using this 
software to the hard disk of the MS2690A/MS2691A/MS2692A or 
MS2830A, refer below: 

• Section 2.4.4 “Copying waveform file(s) to hard disk” in the 
MS2690A/MS2691A/MS2692A Signal Analyzer Option 020: Vector 
Signal Generator Operation Manual (Operation) 

• Section 2.4.4 “Copying waveform file(s) to hard disk” in the MS2830A 
Signal Analyzer Vector Signal Generator Operation Manual 
(Operation) 

Note:  
Transferring waveform patterns is not required if the patterns are 
created using this software. 

 

4.2.2 Loading to Waveform Memory 
In order to output a modulated signal using the waveform pattern, it is 
necessary to load the waveform patterns stored in the internal hard disk 
to the waveform memory.  

■Loading to Waveform Memory 
Waveform patterns can be loaded to waveform memories by operating the 
panel or by using a remote command.  

For operation using the front panel, refer below: 

• Section 2.4.1 “Loading waveform file in memory” in the 
MS2690A/MS2691A/MS2692A Signal Analyzer Option 020: Vector 
Signal Generator Operation Manual (Operation) 

• Section 2.4.1 “Loading waveform pattern(s) to memory” in the 
MS2830A Signal Analyzer Vector Signal Generator Operation 
Manual (Operation) 
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For operation using remote commands, refer below: 

• MS2690A/MS2691A/MS2692A Signal Analyzer Option 020: Vector 
Signal Generator Operation Manual (Remote Control) 

• MS2830A Signal Analyzer Vector Signal Generator Operation 
Manual (Remote Control) 
 

4.2.3 Selecting Waveform Pattern 
Select waveform patterns to be used for modulation from those loaded in 
the waveform memory as described in Section 4.2.1 “Transferring 
waveform pattern to internal hard disk” above. 

■Selecting waveform pattern 
Waveform patterns to be used for modulation can be selected by 
operating the equipment panel or by using a remote command.   

For operation using the front panel, refer below: 

• Section 2.4.2 “Loading waveform file in memory” in the 
MS2690A/MS2691A/MS2692A Signal Analyzer Option 020: Vector 
Signal Generator Operation Manual (Operation) 

• Section 2.4.2 “Loading waveform pattern(s) to memory” in the 
MS2830A Signal Analyzer Vector Signal Generator Operation 
Manual (Operation) 
 

For operation using remote commands, refer below: 

• MS2690A/MS2691A/MS2692A Signal Analyzer Option 020: Vector 
Signal Generator Operation Manual (Remote Control) 

• MS2830A Signal Analyzer Vector Signal Generator Operation 
Manual (Remote Control) 
 

 



 

Chapter 4  How to Use Waveform Patterns 

4-8. 

 



 
Appendix 

App.-I 

A
ppendix 

 

Appendix A Error Messages .............................................  A-1 
Appendix B User File Format ...........................................  B-1 
 
 

 



 

Appendix 

App.-II. 

 



 
Appendix A  Error Messages 

A-1 

A
p

p
en

d
ix

A
ppen

dix A
 

A list of error messages is shown below. In this list, x, n1, and n2 indicate 
a numeric value, and s indicates a character string. 

Table A-1  Error messages 

Error Messages List Message Content 

Cannot read file (“s”). — 
Cannot write file. — 
Cannot write file (“s”). — 
Input Export File Name. — 
Input Package Name. — 
Invalid file format — 
The Setting value is out of range. (“s = x(n1 – n2)”) — 
Invalid Setting. — 
The RU is occupied already. — 

Change Time Slot or Channel Code.  
Selection of an inaccurate file. ("") — 
Not enough hard disk space. — 
Folder or media not found. Aborted with error. — 

The Waveform data file is not generated. Waveform is not yet generated. To draw, generate 
waveform.  

FTP connection error. Check the network setting of MG3700A, 
MG3710A, or your PC.  

 
A list of warning message is shown below. 

Table A-2  Warning message 

Warning Message Message Content 

A Transfer wizard is already running. — 
Clipping was done. — 
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This section shows examples of the user file format that can be used in 
this software. A user file must be a text file. It is not necessarily required 
to specify an extension to user files. Note that an error occurs if a user 
file that does not conform to the format is read.  

 

Be sure to write an unmodulated binary sequence into a user file. An 
error occurs if a user file that contains characters other than 0, 1, line 
feed, comma, period, and space is read. All line feeds, commas, periods, 
and spaces in a user file are ignored when the user file is read. 
A user file format example is shown below. 

User file format example   

0s and 1s in a user file are sequentially read from the leftmost of the first 
line. 

When the number of data to be processed is larger than that in the user 
file, the user file is read again from the top. If the user file contains more 
data than that to be processed, data reading terminates halfway. 
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